
1IBM FileNet P8 Platform

Troubles

Version 4.0 and 4.5

���
hooting Guide
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE

GC31-5493-03



2

IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



3IBM FileNet P8 Platform

Troubles

Version 4.0 and 4.5

���
hooting Guide
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE

GC31-5493-03



4

Note

Before using this information and the product it supports, read the information in “Notices” on page 91.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE
© Copyright International Business Machines Corporation 2001, 2009.
US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract
with IBM Corp.



 Table of Contents 5
Table of Contents

Revision log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

About this document  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Document organization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Recommended documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10
Contact customer support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

General  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Application Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12
Workplace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Workplace XT  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Application Integration BCS  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21

Content Engine  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Deployment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Enterprise Manager. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Content Engine Upgrader (version 4.0.1 to 4.5) tool. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Content Engine Java and .NET APIs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Databases . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Microsoft SQL Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Oracle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
DB2 for z/OS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Business Process Management  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Process Engine. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Process applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Security  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Application Engine, Content Engine, and Process Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
Windows’ Data Execution Prevention feature prevents BPM-related Java processes from running  . 49

Content Federation Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Content Services (CFS-CS) and IICE (CFS-IICE)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50
Image Services (CFS-IS)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

Records Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE



 Table of Contents 6
File Plan Import and Export Tool. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

Rendition Engine . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
Publishing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

IBM FileNet Connectors for SharePoint. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Application servers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
WebSphere . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
WebLogic  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Browsers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Microsoft Internet Explorer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
Netscape Navigator. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

FileNet P8 documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Process Engine errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
Errors that require administrator intervention . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

Email Manager errors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Server errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
Client errors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
Errors that require administrator intervention . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

Content Federation Services Errors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84
Content Services (CFS-CS) and IICE (CFS-IICE)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 84

Software builds and Win32 errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
Identifying software build information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88
Win32 0x800xxxxx error decoding  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 88

Notices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
Trademarks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE



 Revision log 7
Revision log
The following table identifies changes made to this document.

Date Revision
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• Creating a large choice list in IBM DB2 for z/OS fails with SQL error code 805.

• Content Engine Upgrader (version 4.0.1 to 4.5) tools

• Content Engine diagnostic information

Added the following new topics to the IBM FileNet Connectors for SharePoint 
section:

• Kerberos authentication failed.

• Authentication errors occur and prevents communication.

Added the following new topic to the Workplace applications section:

• Transparency for annotations is no displayed by default in Image Viewer.

Added the following new topics to the Records Manager section:

• The RMBaseURL can become outdated when the RM URL changes

• New WSI retry configuration option

• Corrupted entities if Hold Sweep is terminated in the middle of its run

Added the following new topics to the Security section:
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• Windows’ Data Execution Prevention feature prevents BPM-related Java 
processes from running

Added the following new topic to the Database > DB2 for z/OS section:

• AddOn installation can fail with resource unavailable exception

Added the following new topic to the Application Server > WebSphere section:

• Creating FileNet P8 domain or object store fails, when database is DB2 for 
z/OS

Added the following new topics to the Workplace XT section:

• Unable to see the IBM ECM tab on the Microsoft Office 2007 Ribbon.

• Unable to send e-mail.

• Cannot upload or download a file larger than 100 MB.
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10/07/08 Added the following new topics:
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Date Revision
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• Content Engine. What do the storage area counters count?

• Content Engine. Cannot add documents to a file or fixed storage area.

• Content Engine. Do the storage area maximums control how much data can 
be stored on the fixed content device?

• Content Engine. What's the staging area directory used for? Do I need to 
back it up?

• Content Engine. Why don't the storage area counters change when I add a 
document to a fixed content device?
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• CFS-CS and CFS-IICE. Resolving Deadlock errors when federating large 
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• CFS-CS and CFS-IICE. Content Services (CS) limits the number of 
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• CFS-IS. IP address change for IS connection is not propagated to Content 
Engine application server. 
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• CFS-IS. How large are IS Annotations?

• CFS-IS. Can I delete federated IS Annotations from a FileNet P8 application?

• CFS-IS. How do I transfer my IS document class mapping from one object 
store to another?

• CFS-IS. Is there a limit for the number of concurrent FileNet P8 users 
accessing documents stored on the IS server?

• CFS-IS. Why does my custom application take up so many IS sessions when 
not that many users are accessing documents at the same time?

• CFS-IS. How many IS sessions do the IS Import Agents use?

• CFS-IS. How do I increase my throughput when federating millions of 
documents?

03/05/07 Initial document release.

Date Revision
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About this document
This document provides troubleshooting tips for the IBM® FileNet® P8 system.

Document organization
Troubleshooting tips are listed only once, and they are organized by how a problem manifests or by the 
major area associated with a task or operation. For example, if you cannot launch a workflow from 
Workplace, check for troubleshooting tips under Workplace and under Process Engine workflows. 

NOTE Most topics have both a cause and a solution. However, some topics just have tips that are 
associated with the heading topics. 

Recommended documentation
The following IBM FileNet documents also provide problem solving information:

• IBM FileNet P8 Release Notes (known issues). 

• IBM FileNet P8 Performance Tuning Guide

To download these documents from the IBM support page, see the following “Access IBM FileNet 
documentation” topic. 

Access IBM FileNet documentation
To access documentation for IBM FileNet products: 

1. Navigate to the Information Management support page (www.ibm.com/software/data/support). 

2. Select the appropriate IBM FileNet product from the "Select a category" list. For IBM FileNet P8 
products, select either FileNet Business Process Manager or FileNet Content Manager.

3. From the Product Support page, click Documentation, and then click Product Documentation. 

4. Click the icon in the appropriate release column to access the document you need. For IBM FileNet P8 
products:

• If necessary, click a product Doc Link to display the list of component product documentation.

• Click the icon in the appropriate release column to access the document you need. 

Contact customer support
For information about contacting customer support: 

1. Navigate to the Information Management support page (www.ibm.com/software/data/support). 

2. Select FileNet Product Family from the "Select a category" list. 

3. From the FileNet Product Family support page, click View all Flashes, and then select How to get 
support for IBM FileNet products.

a. Click Matrix to access the compatibility matrix.

b. Click the release number to access the fix pack you need.
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General

Tips

Directory servers
When you set up the directory server, avoid using duplicate short names.

Keep the security implementation simple. Unusually restrictive or complex security policies can cause the 
system to operate in ways that you might not expect.

Databases
If a database is configured to be case-sensitive, the case of stored pathnames must match the case of the 
path to the referenced item.

Server date and time 
Synchronize the date and time on all servers. Users can experience a variety of problems if one or more 
servers are not synchronized with the rest of the system. 

Release version and build information
To determine the release version or build information for your software, see “identifying Software 
Build Information” at the end of this document.
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE
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Application Engine

Workplace 

Log on and log off

Unable to log on
Solutions:

• Verify the Content Engine application server is running.

• Verify all operating system and application server patches and fix packs have been installed.

• For more information, see the IBM FileNet P8 Hardware and Software Requirements Guide. To 
download this document from the IBM support site, see ““Access IBM FileNet documentation” on 
page 10.

• Verify access between Application Engine and Content Engine. 

• From the Application Engine server, ping the Content Engine server hosting the Application 
Engine Web Connectivity (Java™) module, and from the Content Engine server hosting the 
Application Engine Web Connectivity (Java) module, ping the Application Engine server.

• Verify at least one object store has been created on Content Engine.

• Verify the Content Engine name in the WcmApiConfig.properties file is correct, and was not 
misspelled or incorrectly specified during Application Engine installation. 

• For more information, see the FileNet P8 Help system: FileNet Documentation > FileNet P8 
Administration > Application Engine Administration > Key configuration files and logs > 
CryptoKeyFile.properties.

• Verify bootstrap preferences were configured.

• Test EJB communication: View http://content_engine_name:port_number/FileNet/Engine.

• Verify the user’s short name does not match the short name of a different user. 

• Normally, users can log on using either their short name or their distinguished name. However, 
eDirectory or a Sun ONE directory servers in a multi-domain environment where duplicate short 
names are being used, require users with identical short names to log in using their distinguished 
name. (For example: uid=dsmith,ou=Sales,dc=FileNet,o=com.) 

• Verify the user belongs to a default Content Engine and Process Engine domain. 

• Active Directory servers require users who do not belong to a default Content Engine and Process 
Engine domain to log in using their long name. (For example: mjones@filenet.com.) 

• Check log in failure details under root exception when you use long keys for symmetric encryption 
or user tokens (required for Application Integration).

• The following message indicates you have not added the unlimited strength jars to 
your JDK directory. 

Root Exception:
com.filenet.wcm.api.EncryptionException: Problem initializing encryption/
decryption with keyId be4b25d1, size 448 bits. java.home=C:\j2sdk1.4.2_03\jre. 
Cause: java.lang.SecurityException: Unsupported keysize or algorithm 
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE
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parameters

• The following message indicates you should verify the java.security file is using the 
proper JCE. 

Root Exception:
com.filenet.wcm.api.EncryptionException: Problem creating JCE Cipher instance 
for Blowfish/ECB/NoPadding algorithm. java.home=/export/home/bea/jdk131_08/
jre. Cause: java.lang.NoClassDefFoundError

• (WebSphere® only) The following message indicates that the LTPA security 
information is not properly synchronized in a WebSphere ND environment. The LTPA 
settings at the deployment manager were not propagated to the managed node to 
which Content Engine was deployed. This results in a situation where the Application 
Engine Admin and managed nodes are in synch with the Content Engine Admin node, 
but not with the Content Engine managed node.

Root Exception: 
Credentials Exception
at com.filenet.wcm.toolkit.server.base.WcmSignInPolicy.setCredentials 
(WcmSignInPolicy.java:475)
at 
com.filenet.wcm.apps.server.controller.WorkplaceSignInPolicy.setCredentials 
(WorkplaceSignInPolicy.java:98) 
at com.filenet.wcm.toolkit.server.util.SSLSignInToken.authenticate 
(SSLSignInToken.java:112)
at com.filenet.wcm.toolkit.server.base.InternalTokenPolicy.setCredentials 
(InternalTokenPolicy.java:75)
at com.filenet.wcm.toolkit.server.base.WcmController.tryInternalUserToken 
(WcmController.java:2926) 

Manually copy the security.xml file from the Admin node to the managed node. 

“Invalid Credentials” message displays at log on.

Cause: The user name or the password was typed incorrectly.

Solution: Check the Caps Lock key, and then log on again.

Cause:

• The account is locked.

• The account requires a password change.

• The account is disabled.

Solution: Check with the system administrator about the account.

Cause: User does not have a valid domain account.

Solution: Verify the user has a valid domain account and is not trying to log on using a machine 
account instead of a domain account.

Cause: The web server is not pointing to a valid location for the Application Engine Web 
Connectivity (Java) module.
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE



 Application Engine
Workplace

14
Solution: Open the WcmAPiConfig.properties file and verify the web server is pointing to a valid 
location for the Application Engine Web Connectivity (Java) module. 

For more information, see the FileNet P8 Help system: FileNet Documentation > FileNet P8 
Administration > Application Engine Administration > Key configuration files and logs > 
WcmApiConfig.properties.

Cannot access Image Services documents by proxy from Workplace
Solution: Verify the ISRA (Resource Adapter) is installed.

1. Launch your browser.

2. Enter the URL for the Application Engine ISRA servlet, for example,

http://ApplicationEngineISRAServlet servername:port/ApplicationEngineISRAServlet/ISRA

NOTE ApplicationEngineISRAServlet is the default context root. If a different name was used 
for the context root when Application Engine ISRA servlet was deployed, change the URL to 
match this configuration.

If the ISRA servlet is installed and deployed correctly, a Congratulations message displays. For 
example:

Congratulations! ISRA Interface servlet is configured at this URL.
WcmApiConfigFile = D:\ISRAInterface\jsp\WEB-INF\WcmApiConfig.properties
WcmApiConfig file exists

CryptoKeyFile/UserToken = 
C:\ProgramFiles\FileNet\Authentication\UTCryptoKeyFile.properties
CryptoKeyFile/UserToken exists

FileNet ISRA classes are in the classpath
com.filenet.is.ra.cci.FN_IS_CciConnectionSpec

“Credential is not available” 
Cause: When you log off from Workplace but still have a session for a Process applet running 
(such as Process Designer or Process Configuration Console) and you try to log on to Workplace 
again, the existing user's token will not match that of the Workplace session and the “Credential is 
not available” error message displays.

Solution: Exit any applets and close the browser, then restart the browser and log on to 
Workplace.

Unable to log out of Workplace after using Image Viewer
Cause: Image Viewer caches information to the user profiles, increasing its size and exceeding 
the corporate-set limits for a client. After the limit is exceeded, the profile requires manual 
intervention to remove the Image Viewer files from the profile, which enables the user to log off.

Solution: Edit the AE_install_path\Workplace\UI-INF\jsp\ui\WcmJavaViewer.jsp file to set the 
location of the folder for the cachePath setting. The following example sets the cachePath location 
to c:\mytempfolder.

NOTE Configuration parameters for the Image Viewer. Many of these parameters are necessary 
for FileNet P8 to function normally. It is important that you do not modify any of the FileNet 
parameters. 

writeParam('code', 'ji.applet.jiApplet.class')
writeParam('codebase', './FnJavaV1Files/');
writeParam('JavaScriptExtensions', 'true');
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writeParam('cache_archive', archive );
writeParam('cache_version', cacheVersion);
writeParam('cachePath', 'c:\mytempfolder');

Document processing

Workplace folders fail to refresh after filing or unfiling a document
Cause: Workplace does not perform a refresh after a document has been filed or unfiled. 

Solution: Log off and log back on. Or, click on the end of the folder path.

Out-of-memory errors (java.lang.OutofMemoryError)
Cause: Workplace does not have enough allocated memory while processing a large number of 
records.

Solution: (Designer and administrative applets on client machines) Increase the Java heap value 
from the default 64m to 256m.

1. From the Control Panel, select the Java Plug-in. 

2. In the Java Run Time Parameters field, enter: 

-Xmx256m

Solution: (Application server) Increase the minimum and maximum Java heap values in your 
startup script to 256m and 512m.

NOTE See your application server documentation for the recommended minimum and maximum 
heap size values.

System performance is not optimal
Cause: An excessive number of subfolders in a single folder can affect retrieval performance.

Solution: For information, see the section about handling a large number of folders and objects in 
the IBM FileNet P8 Performance Tuning Guide. To download this document from the IBM Support 
site, see “Access IBM FileNet documentation” on page 10.

Workplace applications

Unable to access Workplace applications
• Verify all recommended operating system and application server patches and fix packs have been 

installed.

For more information, see the IBM FileNet P8 Hardware and Software Requirements 
Guide. To download this document from the IBM support site, see “Access IBM FileNet 
documentation” on page 10.

• Verify access between Application Engine and Content Engine. 

• From the Application Engine server, ping the Content Engine server hosting the Application 
Engine Web Connectivity (Java) module, and from the Content Engine server hosting the 
Application Engine Web Connectivity (Java) module, ping the Application Engine server.

• Verify users have valid credentials as configured on the directory server, and that these credentials 
have access to the object stores.

• Verify users have access to the object store where the site preferences are stored.
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File Tracker

File Tracker functionality fails in a Windows Vista FDCC environment
For information, see “File Tracker functionality fails in a Windows Vista FDCC environment” on page 20.

File Tracker does not keep track of checked-out files
Cause: File tracking is not available in NTFS systems when a file is moved: 

• To or from a FAT system

• Within a FAT system

Cause:

• ActiveX controls might be disabled.

• File Tracker might not be installed.

• File Tracker might be turned off.

Solution: Enable ActiveX controls. Install or turn on Workplace File Tracker. 

NOTE Users must log off and log back on after you enable ActiveX controls and after you install or 
turn on Workplace File Tracker.

Application Integration

Unable to authenticate using Application Integration for Microsoft Office
Cause: Microsoft® Internet Explorer on Windows® Vista checks the Certificate Revocation List 
(CRL) by default, whereas Windows XP does not.

Solutions: For Secure Sockets Layer (SSL) authentication to work, you must: 

• Have a valid certification chain, including a valid LDAP path to the CRL validation server, with 
correct CRL list checking

• Clear the “Check for server certificate revocation” check box in the Internet Explorer properties. 

Image Viewer

Transparency for annotations is not displayed by default in Image Viewer
Solutions:

Make the following changes to your HTML code.

1. Locate the following line:

writeParam('annotationHideContextButtons', 'hyperlink,behind, transparent');

This line indicates to Image Viewer that the semi-transparency button must be disabled. This 
is a clear indication to the viewer that type of transparency is not wanted.

2. Make the following changes to that line:

writeParam('annotationHideContextButtons', 'hyperlink,behind);

This removes the hide transparent option and the button reappears. In Image Viewer, you can 
right-click an annotation to see the button. A rectangle window pane is also displayed. This is 
the semi-transparency property. If the button is hidden as in the current HTML code, the 
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button will not be displayed. When you Write permission to the IS annotation, you can right-
click the button and access the context menu.

Make the following changes to the application code:

1. Locate the following lines:

writeParam('annotationhidebuttons', 'line, solidtext, highlightpoly,

rectangle, redact, redactpoly, poly, openpoly, oval, hyperlink, transparent');

writeParam('annotationHideContextButtons', 'save,text,hyperlink,behind');

= writeParam('annotationHideContextButtonsids', 
'note,freehand,stamp,arrow,highlight,text, 

transparent');

2. Make the following changes to those lines:

writeParam('annotationhidebuttons', 'line, solidtext, highlightpoly, 

rectangle, redact, redactpoly, poly, openpoly, oval, hyperlink');

writeParam('annotationHideContextButtons', 'save,text,hyperlink,behind');

writeParam('annotationHideContextButtonsids','note,freehand,stamp,arrow,highlight,t
ext');

3. Locate the following lines:

writeParam('annotationhidebuttons', 'redact, redactpoly, hyperlink, transparent');

writeParam('annotationHideContextButtons', 'hyperlink,behind');

4. Make the following changes to those lines:

writeParam('annotationhidebuttons', 'redact, redactpoly, hyperlink');

writeParam('annotationHideContextButtons', 'hyperlink,behind');

User interface

Images do not display in Workplace
(WebSphere) Regenerate the plug-in and restart your HTTP server.

• Attempt to connect directly through WebSphere's default port (usually 9080).

• Attempt to load the Workplace applications by accessing the system through WebSphere's default 
port (usually 9080), bypassing the separated HTTP servers.

Name field on Tasks pages is truncated
NOTE Workplace Tasks pages are: My Inbox, Public Inbox, My Active Workflows, and Task 
Tracker.

Cause: The corresponding F_Subject field value is not set high enough to display the entire 
name. 
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Solution: Change the F_Subject field value for the corresponding queue or roster.

Use the Process Configuration Console to modify the length of the F_Subject field for any queue 
or roster. By default, the F_Subject fields are set to a length of 80; you can increase each one to a 
maximum of 255 characters. 

NOTE Changes are applied once they are saved. However, existing work item names will not 
change length. Only work items that entered the queue after you made the change will reflect the 
new length specification. 

Localization

Workplace and Workplace applets do not display a newly selected language

Solution: Reset the browser language setting:

1. Confirm the IBM FileNet P8 language packs are installed. 

2. Confirm the browser language setting.

3. Exit the JVM by exiting all open applets and closing all browser windows. 

4. Open the browser and navigate to Workplace.

Table 1: 

Task page... Change the F_Subject setting in...

My Inbox Inbox user queue

Task Tracker Tracker user queue

Public Inboxes name work queue

My Active Workflows The roster associated with the workflow. 

To determine which roster is associated with a workflow, open 
the workflow definition in Process Designer and look for the 
roster specification in the Workflow Properties dialog box, 
Advanced tab.

Because the Launched Workflows view can contain workflows 
associated with different rosters, and the F_Subject length is 
specified for each roster, the number of characters visible in the 
Name field can vary from workflow to workflow.
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Search

Cannot execute a search
The stored search might not have the proper MIME type. This is caused when the stored search is 
checked in to Content Engine using a tool other than the stored search API. (For example, the 
stored search was checked in using Enterprise Manager). 

Content-based searches do not return results
• The object store is not configured to support content indexing.

For more information, see the FileNet P8 Help system: FileNet Documentation > FileNet P8 
Administration > Content Engine Administration > Content-based retrieval > Concepts > 
About Indexing.

• Stop words were used with the AND operator. 

For more information, see the FileNet P8 Help system: FileNet Documentation > Workplace 
> Advanced Author Tools > Search Designer > Reference > Stop Words. 

Search Designer (or Publish Designer) does not start when Application Engine uses 
WebLogic 9.2 
Cause: “The Web App File Case-Insensitive" setting is set to "os".

Solution: Change the “Web App File Case-Insensitive" setting to "false":

1. Log into the WebLogic administrative console.

2. From the Domain Configurations menu, click Domain.

3. From the Security > General tab, expand the menu by clicking on the Advanced link.

4. Verify the “Web App File Case-Insensitive" value is set to "false". 

Full-text retrieval is not available
Cause: Full-text indexing is not enabled on the object store. 

Solution: Configure the object store for full-text indexing. 

For more information, see the FileNet P8 Help system: FileNet P8 Documentation > FileNet P8 
Administration > Content Engine Administration > Content-based retrieval > Concepts.

Web Services indicate Application Engine cannot be found: "Wrong server name”
Cause: On a FileNet P8 system with a load balancer (hardware or software) for multiple 
Application Engine servers, the reply message might not reach the Application Engine that is 
waiting for the reply.

Solution: For each Application Engine server, edit the P8BPMWSBroker.properties file located in 
the Application Engine Install directory (typically c:\Program Files\FileNet\AE\Workplace\WEB-
INF\P8BPMWSBroker.properties). 

In the P8BPMWSBroker.properties file, add a property listener.local.host, and set the value to the 
current Application Engine server with the format host:port. 

For example, listener.local.host=appserver1\:9002

Do not change the value of property listener.base.url.
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Workplace XT

General

Log on error when the trust association is enabled on WebSphere 6.0.2.17
When the trust association is enabled on WebSphere 6.0.2.17, a Workplace XT user might 
encounter the following errors: 

• Invalid credential entered. Please try again.

This error message also appears when a user logs in to FileNet Workplace or the 
WebSphere console. 

The user must log in again to bypass the message.

• Attempts to use hyperlinks to access Workplace XT content fail. 

The user is redirected to the default browse page instead of getting the requested 
document.

Solution: These failures are caused by a known issue that is resolved in WebSphere 6.0.2.19. 
See the IBM Support web site for more information:
http://www-1.ibm.com/support/docview.wss?rs=0&uid=swg24015036

The folder selector does not display correctly
Cause: The folder selector does not have room to position itself correctly at low screen 
resolutions (1024x768 or lower).

Solution: Increase your screen resolution, or try one or more of the following options to provide 
more room for the folder selector:

• Maximize your browser window.

• Turn off your browser toolbars.

• Turn off your browser menus.

Alternatively, you can create a bookmark or favorite to automatically open your browser window 
with the toolbars and menus turned off. To do so, use the following URL, replacing 
WorkplaceXTURL with the URL for your Workplace XT Web site and adjusting the height and 
width as needed:

javascript:(function() {win = 
window.open('WorkplaceXTURL','','scrollbars=yes,menubar=no,height=600,width=900,resizable=
yes,toolbar=no,location=no,status=no');}) ()

File Tracker functionality fails in a Windows Vista FDCC environment
Cause: (Application Engine and Workplace XT) If File Tracker fails to download, delete a local 
copy, or open on check out in a Windows Vista Federal Desktop Core Configuration (FDCC) 
environment, the Application Engine or Workplace XT server was not set as a trusted site, or the 
Microsoft group policy setting for trusted sites did not propagate properly. 

Solution: Contact Microsoft support for instructions to apply the group policy setting for trusted 
sites. 
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Cannot upload or download a file larger than 100 MB
Solution: Try one of the following options:

• Check the available disk space on your Workplace XT application server.

When you upload and download files from Content Engine, the files are temporarily stored in 
the Workplace XT upload and download directories on the application server, in the following 
default locations:

install_path/FileNet/WebClient/upload

install_path/FileNet/WebClient/download

• Review the recommendations for database, application servers and Content Engine large 
content uploads and downloads in the IBM FileNet P8 Performance Tuning Guide. To 
download this document from the IBM support site, see “Access IBM FileNet documentation” on 
page 10.

• Review the recommendations for handling large file uploads and downloads in your 
application server, browser, and operating system documentation.

Application Integration BCS

Unable to see the IBM ECM tab on the Microsoft® Office 2007 Ribbon
Cause: The IBM ECM tab appears on the Ribbon after Application Integration BCS is installed. 
Application Integration BCS is a Microsoft Add-on. In some instances, the IBM ECM tab no longer 
appears because the add-on becomes disabled. 

Solution: Follow the Microsoft instructions for enabling an add-on when it is disabled.

Unable to send e-mail
Cause:The following issues occur when you are sending e-mail from an integrated Microsoft 
Office application and Outlook is your e-mail client:

• When Outlook is not started prior to sending an e-mail from an integrated application, the IBM 
ECM tab does not appear on the Ribbon. 

• When Outlook is open and you send an e-mail from an integrated application, it appears as if 
Outlook failed to send the e-mail message because the window does not close; however the 
message is sent.

Solution: Follow the Microsoft instructions to download and install the Microsoft hotfix from http://
support.microsoft.com/kb/957692
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Content Engine

Deployment

Content Engine diagnostic information
When Content Engine fails to deploy, verify the state of the deployment as follows:

1. Browse to the following web page:

http://server:port/FileNet/Engine

where:

server is the host name of the machine where Content Engine Server is deployed.

port is the HTTP port used by the application server where Content Engine Server is deployed. 

Example web page addresses are shown in the following table:

NOTE It is a best practice to bookmark the web page address in your browser.

2. Verify your installation by checking the following information on the web page:

a. The value for the Startup Message key, which shows the Content Engine build and version 
(for example, dap440.001.008), must match the build and version in the ce_install_path/
ContentEngine/ce_version.txt file.

b. The value for the Process Engine key, which shows the Process Engine Client build and 
version (for example, pui410.010), must match the build and version in the pe_client 
_install_path/version.txt file, where pe_client_install_path is the path to the directory where you 
installed the Process Engine Client files.

c. The values for JDBC driver, server instance, operating system, etc. must match the values 
you chose when planning the IBM FileNet P8 installation.

Content Engine failed to deploy
Cause:

WebSphere

Incorrect CLASSPATH setting in the startWebLogic.cmd/.sh startup script for the JDBC driver.

WebLogic 

Incorrect environment variable setting to the JDBC driver path.

Solution: 

WebSphere

Application Server Type Web Page Address

WebSphere  http://server:9080/FileNet/Engine

WebLogic  http://server:7001/FileNet/Engine

JBoss  http://server:8080/FileNet/Engine
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Verify the WebSphere environment variables for the JDBC drivers are at both the cell and 
node levels. 

• WebSphere and WebLogic

• Launch the application server console and test the datasources and the connection pools.

• Verify you are using the latest supported JDBC drivers. 

For a list of the currently supported drivers, see the IBM FileNet P8 Hardware and 
Software Requirements Guide. To download this document from the IBM Support site, see 
“Access IBM FileNet documentation” on page 10.

Cause:

(WebLogic only) The default authentication provider is set to the default value of Required. When 
this value is required, the directory server that you specified during installation must exist as a 
WebLogic default authentication provider. 

Solution:

Create a WebLogic default authentication provider with the same name as directory server user or 
change the Provider Control Flag to Sufficient.

The size of the SystemOut.log file causes errors
Cause: (WebSphere 6.0 only) The SystemOut.log file is too large. Heavy throughput and a long 
durations of sustained activity increases the size of the SystemOut.log file and can consume a 
substantial amount of disk space. Multiple warnings similar to the following are logged:

[5/23/07 16:42:21:516 PDT] 0000000a ConnectionFac W   J2CA0294W: Deprecated usage of 
direct JNDI lookup of resource GCDDBXADS.  The following default values are used: 
[Resource-ref settings]
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Solutions:

• A WebSphere fix pack is available. See the IBM Support web site (http://www-1.ibm.com/support) 
for PK06395: J2CA0294W: Deprecated usage of direct JNDI lookup of resource.

• Use the following syntax to set the logging level to severe to suppress the warning message 
"J2CA0294W" from the SystemOut.log:

*=info:com.ibm.ejs.j2c.ConnectionFactoryBuilderImpl=severe

The severe setting suppresses the logging of “warning” and lower 
level messages. See the WebSphere documentation for more 
information on log level settings, or see the IBM Support web site 
(http://www-1.ibm.com/support) for this article: J2CA0294W: 
Deprecated usage of direct JNDI lookup of resource.

Enterprise Manager

Cannot access Enterprise Manager features
Solution: For more information, see the FileNet P8 Help system: FileNet P8 Administration > 
Enterprise-wide Administration > Content Engine Administration > About Enterprise Manager > 
How to... > Start the Enterprise Manager.

Enterprise Manager does not load

Cause: Administrator removed all permissions from the ACL of the domain root (Enterprise 
Manager Domain Root > Properties > Security) by mistake. Enterprise Manager will not load and 
the domain object will not be accessible via the API. 

Solution: Contact your service representative.

Recently created objects or properties do not display or display incorrectly
Solution: Refresh the metadata by right-clicking the object store node and selecting Refresh. 
Recently created or edited objects and properties should display. 

DB2 error occurs while adding a large number of properties to a document class
Cause: When using Enterprise Manager to add a large number of properties to a document class, 
the following DB2® error occurs:

ErrorCode: -1,585, Message: 'A system temporary table space with sufficient page size 
does not exist.'

When this error occurs, you have reached the record length limit and the page size of 32kb. The 
length of all columns of metadata within the table has reached the DB2 limit of 32kb page size.

Solution: Reduce the number of properties or the length of the properties.
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Object stores

Object stores are unavailable
Cause: Each object store has its own ACL and therefore its own list of administrators. Anyone 
who can log on to a server containing Enterprise Manager can open Enterprise Manager, but 
thereafter they must have the correct permissions to open, view, and edit the object store itself.

Solution: Log on to the object store using an account that has Full Control permission to 
administer the object store.

Cannot connect to an object store
Cause: The connection pool might have an insufficient amount of connections. 

Solution: For information, see section about connection pools in the IBM FileNet P8 Performance 
Tuning Guide. To download this document from the IBM support site, see “Access IBM FileNet 
documentation” on page 10. 

Object store creation

Cannot create an object store
Cause: You ar not logged on to Enterprise Manager as a GCD administrator. 

Solution: Log on to Enterprise Manager as a GCD administrator, that is, a user who has Full 
Control access to the FileNet P8 domain.

The “Create an object store” wizard fails during object store creation
Solution: Review the messages displayed by Content Engine or Enterprise Manager as well as 
those appearing in the Object Store Create Status dialog box for the possible source of the error.

Cause: Create database permission is denied in the database. 

• Content Engine administration error message = “Unable to create object store. Error code = 
800710d9.” 

• Object Store Create Status error message = “Unable to read from or write to the database.” 

Solution: The necessary permissions for Content Engine database log on are missing or 
insufficient. 

Cause: Insufficient permission to create a file storage area at this location. 

• Enterprise Manager error message = “Unable to create object store. Error code = 80070005” 

• Access is denied = “Object Store Create Status error message” 

Solution: The permissions on the shared folder for the file storage area are insufficient. 

NOTE The “Create an object store” wizard might display an additional error message that 
indicates the object store creation could not be rolled back, and the new database or tablespace 
for the object store could not be deleted. You can either:

• Delete the entire database or tablespace manually.

• Create a new, empty database or tablespace. 
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• Drop the User tables from the database or tablespace and reuse this database or tablespace when 
you rerun the “Create an object store” wizard. 

For more information, see the FileNet P8 Help system: FileNet P8 Documentation > FileNet 
P8 Administration > Content Engine Administration > Object stores > How to... > Reuse 
databases. 

Cause: The “Create an object store” wizard displays a “not shared” error when you try to select 
the share for use, even though the shared folder exists and proper security has been applied. This 
problem might be caused by an incorrect value in the registry that prevents creation of a file 
storage area object store on a Storage Area Network (SAN) drive device.

Solution: This problem might be related to an issue described in the Microsoft® Knowledge Base 
article ID 106167. Search for “106167” at the Microsoft support web site.

Object stores - object management

Unable to declare records after deleting an object store
Cause: Object store deleted incorrectly.

Solution: You must restore the default preferences in the object store Preferences page before 
deleting an object store. If you fail to do these tasks in the proper order, you will need to clear all 
preferences by deleting, renaming, or moving the bootstrap.properties file. It will be rebuilt 
automatically.

Cannot add documents using a CBR-enabled document class
Verify that both the Content Engine application server and the Autonomy K2 server has access to 
both the file storage area device (if you do not use database storage) and the directory path of the 
Autonomy index area collections (as specified in the verity.cfg file).

Cannot add documents to an Oracle-based object store 
Cause: Bulk addition of large numbers of documents to an Oracle-based object store might fail 
with a RemoteServerException error indicating a session logon failure. The error occurs when the 
number of active Oracle sessions (to update the database when a document is added to a file 
storage area) exceeds the maximum allowed. The underlying problem is that Oracle is retaining 
idle sessions rather than disconnecting them after database transactions are completed.

Solution: As a workaround, run the SQL command CREATE PROFILE to reduce the value of the 
IDLE_TIME resource parameter via the profile of the Content Engine tablespace user that stores 
records in the Oracle database. The IDLE_TIME value determines how long (in minutes) a 
session can be continuously inactive before Oracle ends it. Refer to the SQL command CREATE 
PROFILE in Oracle9i SQL Reference Release 2 (9.2) for details. You might need to experiment 
before determining an optimal value for IDLE_TIME, as it will depend on the amount of activity 
associated with the object store and the database server.

Cannot delete expired documents from a Snaplock device 
Cause: The Snaplock device has its own compliance clock that is used to control all retention 
period related tasks. This clock needs to be synchronized with the Content Engine server system 
clock to within five minutes. The reason for this is that Content Engine sets the retention on a 
SnapLock file as absolute time (for example, "2036-10-19 12:56:01" instead of "NOW + 30 
years"). This time is based on the Content Engine server system clock. If the Content Engine 
system clock is skewed significantly from the SnapLock clock (more than 5 minutes), then the 
absolute retention time is also equally skewed. This could cause a retention problem, and could 
cause the Content Retention Date property of the document object to be inaccurate. 
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Solution: Synchronize the Snaplock device clock with the Content Engine server system clock. 

NOTE The minimum retention period applied to a SnapLock device is expressed in days. 
Therefore, the value of this minimum retention period should not be set to less than 1 day. 

Documents are not being indexed for content or properties
Cause: The template is not recognized during index area creation because the name of the 
template is case-sensitive.

Solution: 

1. Login to the Autonomy K2 Dashboard.

2. Select Collections > Manage Style Sets.

3. Update the case of the Verity Style Set Alias. (For example, FileNet_FileSystem_PushAPI.) 

NOTE This string must match both the string that you have specified in Enterprise Manager and 
the index area properties for the template type. Also, 

(UNIX® only) Autonomy K2 servers had a case-sensitive source path when you first imported the 
style set, Verify you specified the path exactly how it shows on the operating system.

Documents have no audit history
Cause: The object store is not enabled for auditing.

Solution: Enable the object store for auditing.

Cause: The document class is not configured with the correct audit definitions. 

Solution: Configure the document class with the correct audit definitions. 

Creating a large choice list in IBM DB2 for z/OS fails with SQL error code 805.
Cause: The number of allocated DB2 statement handles is insufficient for the number of choice 
values you want to define. The number of available statement handles by default is 1344. 

Solution: Allocate additional statement handles using the DB2 bind command. For example, you 
might enter the following command: 
DB2 bind@db2ubind.lst blocking all grant public sqlerror continue CLIPkg=x 
where x is the number of packages to allocate.

See “CLIPkg CLI/ODBC configuration keyword“ at http://publib.boulder.ibm.com/infocenter/db2luw/
v9r5/topic/com.ibm.db2.luw.apdv.cli.doc/doc/r0008961.html for instructions on using the CLIPkg 
keyword. See “Handles in CLI” at http://publib.boulder.ibm.com/infocenter/db2luw/v9r5/topic/
com.ibm.db2.luw.apdv.cli.doc/doc/c0004933.html for more information about statement handles.

Exporting and importing

The import operation fails
Cause: An object has a circular dependency, and it cannot be imported before the objects to 
which it is dependent. Dependencies might either be explicitly established by setting object-
valued properties that reference other objects that have not be imported, or implicitly, such as a 
class that contains one or more properties, for which the property template definitions have not 
yet been imported. 
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Solution: Remove the dependent objects from the export definition and import the dependencies, 
and then import the dependent objects.

Cause: Circular dependencies exist between two object-valued properties: Object A has a 
property that has object B as its value, and object B has a property that has object A as its value. 
By design, import of this relationship will fail because there is a risk of bypassing the security 
placed on the two objects. The security permissions of the person performing the import might not 
include permissions to access the referred-to object because that object does not yet exist in the 
object store to allow checking the security required by that object.

Solution: Remove the circular dependencies and export/import again, then recreate the circular 
dependency. 
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Cause: When Enterprise Manager detects duplicate object store components in an XML file, it 
cannot successfully create an object store and the import operation fails. 

Solution: Automatic object store population does not allow you to import objects selectively. 
Instead, the system attempts to import all objects included in the XML file. If the object store 
creation fails due to duplicate objects in the XML file, you can remove the XML file using the auto-
import scripts tool. The Import Helper checks for duplicate components and does not overwrite an 
existing object with a duplicate. When encountering a duplicate object, the Import Helper records 
the duplicate entry as an error in a log file and continues to import objects that have not already 
been added to the object store.

Cause: Attempting to import an object that has dependencies before those dependencies have 
been imported, the import operation fails. Dependencies might either be explicitly established via 
object-valued properties that reference other objects which have not yet been imported, or 
implicitly, such as a class that contains one or more properties, for which the property template 
definitions have not yet been imported.

Solution: Remove the dependent objects from the export definition and import the dependencies, 
then import the dependent objects. 

Opening or parsing an import file cause an error
Cause: The pathnames of the xml export files listed in the export manifest file (*.txt) are not 
correct.

Solution: Edit the export manifest file to reflect the actual locations of the export files. 

Associated DRCRs fail during import
Cause: Associated dynamic referential containment relationships (DRCRs) always fail during 
import.

Solution: Use the Enterprise Manager Content Engine Query Builder to search for unfiled 
documents then file them in the correct folders.

Associated subscriptions fail during import
Cause: Associated subscriptions always fail during import.

Solution: Use the Create a Subscription wizard to recreate the subscriptions.

Check security on all objects in the publishing operation such as a source document, publish 
template, publication target folder. For transformation publishing to HTML or PDF, also check 
security on the publish style template.
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Storage areas
The following tips apply to all storage area types (database, file, and fixed storage areas).

Incorrect storage maximums can disable a storage area
Cause: Enterprise Manager settings for the storage area (such as the Statistics tab, Storage Area 
Maximums: Maximum Number of Elements and Maximum Size) can be set to a value much smaller 
than the physical constraints of your storage medium (such as disk space). When one of these 
maximums is reached, the storage area becomes full, and new content can no longer be added to 
it. Enterprise Manager shows the storage area as disabled. Any attempts to add new content 
result in a EngineRuntimeException with code CONTENT_SA_STORAGE_AREA_NOT_OPEN.

Prior to Content Engine 4.0.1 FP2, the default Maximum Number of Elements when creating a new 
storage area was 2500, which for most customers is too small. This limit is easily reached.

Solution:

For versions prior to Content Engine 4.0.1 FP2, perform one of the following:

• If you have reached the maximum number of elements, increase the value for Maximum 
Number of Elements to a very large number to allow new content to be added.

• If you are creating a new storage area, accept the defaults in the Create New Storage Area 
Wizard.

Before any content is added to this new storage area, you can set the Maximum Number of 
Elements to unlimited.

a. Open the property sheet for the new storage area, and select the Statistics tab.

b. In the Maximum Number of Elements field, enter 0. This disables the Maximum Number of 
Elements check.

Once content has been added to this Storage Area, you cannot set the Maximum Number of 
Elements to a value lower than the current content element count.

Storage area counters
The storage area counters count the number of content elements and store the size of each 
element that belongs to the documents and annotations persistently stored in that storage area.

Cannot add documents to a file or fixed storage area
Verify that the RootDirectoryPath property for File Storage Areas and the StagingAreaPath 
property of fixed storage areas are specified from the viewpoint of the Content Engine server. 

In addition, if you are running a server farm or cluster of Content Engine servers, the path to this 
root directory must be the same across all servers. That is, the path should be on a network share 
that is accessible by all Content Engine servers using the same network path and security 
credentials.

The root paths for file storage areas and staging areas should not overlap each other. That is, do 
not embed one file store directory structure underneath another file store's directory structure.

Cannot create a file storage area using a remote or local share

To create, delete, or move file storage areas, you must have started the application server as an 
operating system user that has read and write rights to the device you will be referencing when 
creating or modifying a file storage area.
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Do storage area maximums control the fixed content device?
No. The storage area maximums apply to the content stored in the staging area directory and not 
to the space available on the fixed content device.

What is the staging area directory used for? Do I need to back it up?
The staging area directory is used for both temporary and persistent storage.

When content is added from a FileNet P8 Platform application, it is first uploaded into the inbound 
directory of the staging area. When the upload completes, it is moved to another directory within 
the staging area. Once the document is checked in, the content is migrated to the fixed content 
device, and then it is removed from the staging area directory.

Reservations (documents that have not been checked in), are stored in the staging area directory. 
Since there is no limit between the time a user creates a reservation and then does a check in, 
reservations can exist in the staging area for an undetermined about of time.

Annotations whose storage policy specifies a fixed storage area are persistently stored in the 
staging area directory. Annotations are never migrated to the fixed content device.

For documents that are checked into a fixed storage area whose fixed content device does not 
allow new content (such as CFS-IICE), the content is persistently stored in the staging area 
directory.

For the above reasons, the staging area directory should be backed up.

Storage area counters do not change
The storage area counters do change, but the change can happen so quickly that you do not 
notice the change. The counters are incremented and decremented every time content passes 
through the system. When content is added to a fixed storage device, the counters are 
incremented during the time the content resides in the Content Engine staging area directory. 
However, the counters are later decremented when the content is migrated onto the fixed storage 
device. Thus, when a document is added to a fixed content device, the net change to the count is 
zero.

Annotations that are stored in a fixed storage area always increment the storage area counters 
because the annotations remain in the staging area directory and are never migrated to the fixed 
content device. The storage area counters are also incremented for other types of content that 
remain in the staging area directory, such as reservations.

Do document annotations have to be in the same fixed storage area?
No. However, this depends on the FileNet P8 application that is used to create these annotations. 
The Annotation class has its own storage area and storage policy properties. You can set the 
properties so that the annotations for documents stored on a fixed content device are stored in a 
different storage location, such as the database storage area.

Where are document classes stored when it has no storage area or storage policy?
When an object store is created, the default storage policy added to the document class is the 
database storage policy. Thus, by default, if not otherwise specified, content is stored in the object 
store database.
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Content Engine Upgrader (version 4.0.1 to 4.5) tool

The Content Engine Upgrader tool database connection test fails
Cause: Unfinished events in the event queue when you test the database connection using the 
tool in an upgrade of Content Engine from version 4.0.1 to 4.5.

Solution: Clear any remaining events in the event queue, as follows:

1. Run the following SQL command in the corresponding object store database:

delete from QueueItem where security_id is not null;

2. Test the database connection again in the Upgrader tool, and continue with the upgrade.

Content Engine Java and .NET APIs

Search

WebLogic

A call to SearchScope.fetchObjects with the continuable parameter returns an error
Cause: When the continuable parameter value for SearchScope.fetchObjects is Null or False, 
query results are not paged and every match is returned; limited only by the value of 
ServerCacheConfiguration.NonPagedQueryMaxSize. 

Neither the pageSize parameter (in SearchScope.fetchObjects) nor the default page size in 
ServerCacheConfiguration.QueryPageDefaultSize are used. 

Depending on the value of ServerCacheConfiguration.NonPagedQueryMaxSize, the query results 
can exceed the WebLogic response setting for the T3 protocol:

(E_UNEXPECTED_EXCEPTION wrapping a WebLogic exception)

By default, WebLogic allows a maximum response size of 10MB. 

Solutions:

• Call SearchScope.fetchObjects with the continuable parameter set to true.

• Lower the value of ServerCacheConfiguration.NonPagedQueryMaxSize.

• Increase the response size limit used by the WebLogic T3 protocol.
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Databases

Microsoft SQL Server

Cannot create a row that exceeds 8060 bytes
Cause: Microsoft SQL Server limits the length of database rows to a maximum of approximately 
8060 bytes. Consequently, when you have Microsoft SQL Server installed and you attempt to add 
information to the object store database, you might receive an error message indicating that the 
requested insertion would cause a particular row in the database to exceed the maximum 
allowable length and the insertion will fail.

Solution: This limitation is primarily a concern when adding a large number of custom properties 
to the document base class and subclasses. However, it can also impact development with the 
folder and custom object classes and subclasses. Developers are recommended to subclass the 
FileNet classes and add their custom properties to the subclasses, while maintaining an 
awareness of the current row size. Keep in mind that the total amount of available space in any 
row is confined to the leaf class in which you are currently adding custom properties, as well as its 
superclasses. Available space is not measured for the table as a whole, which represents all 
classes. In addition, when implementing long string properties use the ntext type of the 
UsesLongColumn property as this requires a relatively small amount of space (4 bytes) and can 
be used to represent large strings.

Adding an index on a property indicates the limit of 249 indexes has been reached
Microsoft SQL Server permits no more than 249 property definitions to be used as indexes in a 
document subclass. No matter how many document subclasses you might have in a particular 
object store, the total number of indexes for all document subclasses (or any class, including 
folder and custom object classes) combined cannot exceed 249.

Creating an index on a large object store exceeds the DTC timeout 
Cause: On a large object store with a large number of rows in a table, creating an index might 
take so long that it exceeds the DTC timeout value and result in an exception. The DTC timeout 
value of 60 seconds might be insufficient for very large indexes. 

An event error log similar to the following might occur:

Fnk_CatService.exe hr=80040e14 database.cpp[1189] ($Revision: 1.1 $): A database SQL 
execution error has occurred.

Error: Distributed transaction completed. Either enlist this session in a new transaction 
or the NULL transaction.

Error code: 0x80040e14 Source: Microsoft OLE DB Provider for SQL Server

Native Error: 8525 SQLSTATE: 42000

An exception error with the following code might appear: 

Error Code: 0x800710d9
Unable to read from or write to the database 

Solution: Increase the DTC timeout to a larger value, for example, 3600 seconds.
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Oracle

ORA-12535 TNS: Operation timed out error / ORA-12541 No listener error

Cause: The Oracle QUEUESIZE parameter does not specify enough connections for the listener 
to handle large volumes of concurrent connection requests.

Solution: Change the number of connections defined by the QUEUESIZE parameter.

To set the QUEUESIZE parameter, edit the address line in the listener.ora file as follows: 

(ADDRESS = (PROTOCOL = TCP)(HOST = servername)(PORT = 
servername)(QUEUESIZE=100)) 

Oracle database queries are not finding documents and folders as expected
Cause: Document titles or folder names might have been left empty. 

Solution: See the FileNet P8 Help system: FileNet P8 Documentation > Developer Help > Content 
Engine COM API > COM API Guide > Using the Content Engine Database Engine > Database 
Engine Differences.
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DB2 for z/OS

AddOn installation can fail with resource unavailable exception
When installing larger AddOns (e.g., like those used in Records Manager) into an object store 
whose database is DB2 for z/OS, and a timeout error occurs, you might also get a -904 resource 
exception similar to the following:

2008-10-08T06:25:07.204Z 291E291E API FNRCE0230E - ERROR An error 
occurred accessing the database. ErrorCode: -904, Message: 'DB2 SQL 
Error: SQLCODE=-904, SQLSTATE=57011, 
SQLERRMC=00E70081;00000A00;A12BASE.DOCVERSION, DRIVER=3.51.118' 
SQL: "ALTER TABLE DocVersion ADD COLUMN uee8_rmentitydescription 
vargraphic(1200) 
"\ncom.filenet.api.exception.EngineRuntimeException: DB_ERROR: An 
error occurred accessing the database. ErrorCode: -904, Message: 
'DB2 SQL Error: SQLCODE=-904, SQLSTATE=57011, 
SQLERRMC=00E70081;00000A00;A12BASE.DOCVERSION, DRIVER=3.51.118' 
SQL: "ALTER TABLE DocVersion ADD COLUMN uee8_rmentitydescription 
vargraphic(1200) "

Cause: This message and reason code (00E70081) indicate that the table of the ALTER 
statement (DOCVERSION) is currently referenced by a prepared statement in a prepared 
statement cache and therefore cannot be dropped or altered.

Solution: Disable the prepared statement cache of the object store's XA data source (that is, set 
to size = 0).
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE



 Business Process Management
Process Engine

36
Business Process Management

Process Engine

Server processing errors

vwtool loadstatus
(Non-farmed Process Engines only) Server processing requests can result in errors if inadequate 
system resources are available.The requests are automatically retried, but these retries can result 
in a loss of performance or other issues.

Use the vwtool loadstatus command to determine the rate at which requests and errors occur. The 
rate of processing, type of processing, and any errors that have occurred indicate the system 
resources that might need additional allocations. 

For more information, see the P8 Platform Help topic FileNet P8 Administration > Process Engine 
Administration > Administrative Tools > vwtool > loadstatus for a description of the command with 
the RPC and error counters reported.

“Not enough room in the archiver memory buffer” 
Cause: This error might occur when transferring a workflow definition to the workflow database.

Process Engine limits the size of workflow definitions and workflow maps to 512K bytes for Oracle 
and 64K bytes for Microsoft SQL Server. Any workflow definition or workflow map greater than this 
size will not transfer to the workflow database. 

Solution: Break up a workflow map into submaps, or break up large workgroups into multiple 
subgroups.

Workflows

“This workflow contains errors. It cannot be launched” 
Cause: This error might occur when attempting to launch a workflow.

This message displays if the workflow has validation errors or transfer errors. One possible 
reason for the error is that a step in the workflow definition references a step processor that does 
not exist. 

Solution: Open the workflow definition in Process Designer, and use the Validate command to 
identify any problem steps. This situation can occur if the workflow definition was defined on a 
different system or if a step processor was deleted after it was referenced in the workflow 
definition.

“Unable to get step element” 
Cause: This error might occur when you attempt to open a step assignment from an email 
notification.

Solution: After you complete a work item or return it to a work queue, the work item is no longer 
in your workflow Inbox. However, the email message remains in your email Inbox. You must delete 
the email message manually. The system displays a message that it cannot find the item if you try 
to open the work item from the email message. 
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Users SysAdminG or SysConfigG cannot participate in workflow-related activities
Cause: The names SysAdminG and SysConfigG are reserved for special internal use on Process 
Engine. Use of either one as a short name for a group can have unintended results for your 
workflow system. (While it is unlikely that an actual user will have either of these names, sites 
upgrading from previous versions of Process Engine software might encounter them.)

When Process Engine encounters SysAdminG or SysConfigG in a context where a group is 
permissible, it does not check the directory service for the members of the group. Instead, it 
automatically checks the Process Service properties (set via the Process Task Manager) for the 
directory server group mapped to the Process Engine Administrators Group or the Process 
Engine Configuration Group, respectively, and uses the mapped group for further processing.

This affects:

• Any API that passes the directory server short name as an input parameter 

• Workflow roster, queue, and event log security 

• Workflow participants 

Consider this example using the Active Directory. The following groups are defined in the directory 
service:

• cn=SysAdminG,dc=filenet,dc=com This group has a member named JohnSmith. 

• cn=SysConfigG,dc=filenet,dc=com This group has a member named MaryJohnson. 

• cn=PESysAdminG,dc=filenet,dc=com This group has a member named JaneDoe. 

• cn=PESysConfigG,dc=filenet,dc=com This group has a member named SarahJones. 

• In Process Task Manager, you map the following:

• Process Engine Administrators Group (internal name SysAdminG) PESysAdminG

• Process Engine Configuration Group (internal name SysConfigG) PESysConfigG

Potential results in this case are:

• Workflow steps assigned to SysAdminG (JohnSmith) will instead be routed to members of the 
PESysAdminG group (JaneDoe). 

• A queue that is restricted in access to members of SysConfigG (MaryJohnson) will instead allow 
access to members of the group PESysConfigG (SarahJones). 

• Executing the method IsMemberOf("SysAdminG") for JohnSmith will return FALSE instead of 
TRUE. Executing the method IsMemberOf ("SysAdminG") for JaneDoe will return TRUE instead of 
FALSE. 

TIP To see if JSmith is a member of cn=SysAdminG,dc=filenet,dc=com, provide the full dn to the 
API.

Solution: Do not use the names SysAdminG and SysConfigG for users who will participate in 
workflow-related activities.
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System performance is deteriorating rapidly or the server hard drive is thrashing
• Too many isolated regions

For more information, refer to the FileNet P8 Help system: FileNet P8 Administration > 
Process Engine Administration > System administration tasks > Improving system 
performance > Reducing the number of isolated regions.

• Too many exposed fields or indexes on the workflow rosters, queues, or event logs

For more information, refer to the FileNet P8 Help system: FileNet P8 Administration > 
Process Engine Administration > Workflow administration tasks > Coordinating workflow 
design > Using the Process Configuration Console. 

• An unoptimized query has been executed on the database, usually from a user-defined 
application. Review the queries being executed, and create an index on the associated table if 
necessary. 

For more information, see the to the FileNet P8 Help system: Workplace > Admin Tools > 
Process Configuration Console.

• The server does not meet Process Engine requirements. Evaluate the need for upgrading one or 
more of the following:

• RAM

• Hard drive 

• CPU or entire motherboard 

For more information, see the IBM FileNet P8 Hardware and Software Requirements. To 
download this document from the IBM Support site, see “Access IBM FileNet documentation” 
on page 10.

Items from a specific work class are processing slowly
Cause: Event or trace logging is enabled for the roster. Statistics collection is enabled for the 
roster. 

Solution: See the FileNet P8 Help system: Workplace > Admin Tools > Process Configuration 
Console > Events and statistics.

Nearing the maximum BLOb size
Process Engine logs a warning message in the system event log indicating that the BLOb size of 
a configuration object or a work item exceeds 95% of the maximum allowable size.

The 512K limit on the BLOb size for Oracle is an arbitrary value that is sufficient for most 
applications. The following conditions increase the amount of data stored in the BLOb:

• A large number of work spaces. This is the result of a large number of versions of the same 
workflow definitions transferred to Process Engine in one isolated region. 

• A large number of steps on the main workflow map. This condition can be avoided by breaking up 
the workflow into submaps. 

• A large number of data fields. 

• Large string data fields. 
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Cannot connect to remote Oracle database 
Cause: Process Engine fails to connect to a remote Oracle database (Process Engine LDAP fails) 
if Oracle Names Server (ONAMES) is used for name resolution and the sqlnet.ora file contains 
both of the first two following lines and either one of the second set of following lines:

NAMES.DEFAULT_DOMAIN = world
#SQLNET.AUTHENTICATION_SERVICES=(NTS)

NAMES.DIRECTORY_PATH=(LDAP,ONAMES,TNSNAMES)
NAMES.DIRECTORY_PATH=(ONAMES,TNSNAMES,HOSTNAME)

Solution: Use the help option of the Oracle Names utility namesctl to determine if the site is using 
ONAMES, LDAP, etc. You can use Oracle Net Configuration Assistant to configure a new 
sqlnet.ora file. Then use the tnsping utility to determine if Oracle Client can connect to Oracle 
server. The net service name is defined in the tnsnames.ora file.

Replacing the NAMES.DIRECTORY_PATH line in sqlnet.ora with the following line will also 
resolve the problem (that is, verify that TNSNAMES is the first entry):

NAMES.DIRECTORY_PATH=(TNSNAMES,LDAP,ONAMES,HOSTNAME)

Process applications

Unable to access Process applications
Symptoms:

• Errors occur when accessing Workplace Tasks pages.

• Error occur during automatic launch of a workflow from a subscription.

• A logon dialog box displays when you try to start Process Configuration Console, Process 
Administrator, Process Tracker, or Process Designer.

Solutions:

• Check Process Engine configuration: 

– Verify that Process Engine is configured with a static IP address.

• Check Application Engine configuration: 

– Verify that the correct connection point is indicated in the Site Preferences.

– Verify that the connection point is correctly indicated with the valid Process Engine 
server name and broker port. 

– Verify that Process Engine can be accessed from Application Engine.

– Verify that Process Engine and all required components are running: 

• On Process Engine, run Process Task Manager. The status bar at the bottom of the Task Manager 
window should say “Software is running.” If this status is not indicated, click the Start button on the 
Task Manager toolbar.
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Cannot access workflow tasks
• Verify that you have initialized the isolated region.

• Verify that the correct connection point is indicated in the Site Preferences.

• Verify that the connection point is correctly indicated with the valid Process Engine server name 
and broker port. 

• Verify that Process Engine can be accessed from Application Engine.

Process Configuration Console

Cannot Launch Process Configuration Console
Cause: If Process Configuration Console does not launch, the configuration settings that 
establish communication between Application Engine, Content Engine, and Process Engine when 
the Process Configuration Console is launched might be missing or incorrect.

When Process Configuration Console is launched: 

1. Application Engine retrieves the connection point name from the Workplace site preferences. 

2. Application Engine connects to Content Engine using Enterprise Java Beans (EJB) and the 
connection point name. 

3. Once Application Engine is connected to Content Engine, Application Engine retrieves the 
region ID for the Process Engine server. 

4. Application Engine connect to Process Engine using the region ID. 

Solution: Update the Process Engine region ID to the Process Engine server name or the fully 
qualified DNS name for the Process Engine server.

Solution: 

1. Verify that the Workplace site preferences have the correct connection point name. You can 
verify the connection point name that is configured in the site preferences in: 

Workplace or Workplace XT

a. Log on as a user who is a member of the Application Engine Administrators group. 

b. Click Admin (in Workplace) or Tools > Administration (in Workplace XT). 

c. Click Site Preferences. 

Enterprise Manager

a. Locate the site preferences document in the object store that stores the bootstrap 
preferences file. (The object store that stores the bootstrap preferences is the object store 
that was selected during the first log on to this environment.)

b. Right-click the site preferences file and select View document. 

c. Locate the connectionPoint tag and verify it has the correct connection point name. 

2. Verify the Enterprise Java Beans (EJB) connection to Content Engine. (A successful logon to 
Workplace or Workplace XT confirms the EJB connection to Content Engine.)
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3. Verify the Content Engine connection to Process Engine.

a. From Enterprise Manager, select Process Engine Connection Points from the domain, right-
click the connection point, and select Properties. 

b. Verify the connection point is correctly bound to the correct region ID. (The region ID must 
be either an IP address or a server name that the Content Engine server can resolve.)

c. Ping the Process Engine server from the Content Engine server using the region ID: 

ping peserver1.ibm.com

d. Verify the Process Engine server name does not have a trailing space in the command. 

e. Verify the port number is the same as the Process Engine Communication Port in Process 
Task Manager. 

4. Verify the Application Engine connection to Process Engine.

a. Use one of the following commands to ping the Process Engine server from the Application 
Engine server using the region ID:

• ping peserver1.ibm.com

• JRE/bin/java -cp lib/pe.jar:../CE_API/lib/log4j.jar 
filenet.vw.server.ConfigUtils /url 
http://pe_server:pe_port/IOR/FileNet.Process Engine.vworbbroker 

NOTE the second command is a JAVA command that is ran from the Application 
Engine router directory.

Solution: Start Process Engine tracing on the Application Engine server by placing the 
fnlogging.properties file (used by Process Engine 4.0.0 and 4.0.1) or the fnlog4j.properties (used 
by Process Engine 4.0.2) in to the application server JRE/lib directory. 

NOTE The properties file will need to be modified to set the appropriate log file location. 

The Process Engine trace log provides detailed information about the different communication 
steps mentioned in the previously suggested solution. Once you have the trace file, contact your 
support representative to review the Process Engine trace information. 

Problems started after an isolated region was recovered
Cause: The restore process restores only the vwobject<id> tables, which has only the old 
mapping information between Process Engine and the database tables. Any new tables or views 
that were created from queues, rosters, or logs are now orphaned. 

Solution: Use vwtool to recreate the table or views.
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Process Designer

Validate function does not detect invalid function arguments in a workflow definition 
For example, in a workflow definition, a stringtotime function specifies a time mask "yyyy-mm-dd 
hh:tt:ss am". At runtime, the timestring field value is "06/03/2001 02:10:00 am", which results in 
an error because it does not match the mask.

Cause: The Validate function performs syntax and type checking. It does not validate function 
arguments. In the example above, validation does not check the time mask literal string, and it 
cannot check the timestring field where the actual value is not known at validation time. 

Solution: There is no way to predict invalid runtime values. As a workaround, the effects can be 
made more manageable by using variables to hold literals, rather than entering literals directly. 

In the case of the stringtotime function--stringtotime(timestring, timemask) where the 
workflow author might expect different time formats at runtime, timemask should be a string field 
containing the literal value ("yyyy-mm-dd hh:tt:ss am"), rather than the literal entered directly into 
the function. If a problem occurs at runtime, the workflow administrator can change the value in 
the timemask string field to match the date entered in the timestring parameter ("mm/dd/yyyy 
hh:tt:ss am"); a literal in the stringtotime function cannot be modified in an active workflow.

Process Analyzer

Events are not published to the Process Analyzer
Solutions:

• Verify that the Enable Process Analyzer option is checked in the Process Configuration Console. 

• Verify the PA Engine installation date. Only events generated from the workflows that are launched 
on or after the PA Engine installation date are published to the PA Engine.

• Verify that connection points have been defined on Content Engine for the regions in which you are 
expecting event information to be published to PA.

• In a Process Engine farmed environment, verify that all load balancers have been specified on the 
Process Engine > Servers node within Process Task Manager. 

• Verify that views for the event logs are in the Process Engine database. Event log view names start 
with VWVL. Use the vwtool createDBviews command to create the views if they do not exist. 

NOTE The F_SW user must have permissions to create and drop views; otherwise, the 
views will not get created.

Process Analyzer incorrectly combines data in queues 
Cause: PA does not recognize case in queue names. For example, if a workflow definition refers to 
both wq2 and WQ2, the PA outputs the data for both queues as belonging to wq2.

Solution: Use unique names rather than case to distinguish queues within an isolated region.
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Component Manager 

Auto-starting Component Manager as a WebLogic servlet causes a stack trace error
Cause: Identical domain names, server names, or store names exist within two or more integrated 
WebLogic domains. The resulting stack trace will be similar to the following:

2006.11.13 16:42:25.437 VWAdaptor:JMSQueue run SEVERE JMSQueue adaptor is stopped due to 
exception: Connection not found

. Last status=JMSQueue adaptor performs JAAS login for jaastest with user pwtestadmin at 
November 13, 2006 4:41:07 PM PST.

2006.11.13 16:42:25.531 VWAdaptor:JMSQueue run FINER THROW

weblogic.jms.common.JMSException: Connection not found

Solution: To successfully start Component Manager as a WebLogic servlet when integrating two 
or more WebLogic domains, ensure that the following resource names are unique across all 
domains: 

• Domain name 

• WebLogic server name 

• JMS server name 

• JMS store name 

Restarting Component Manager causes an error
Cause: After reconfiguring Component Manager during a 3.5 to 4.0 upgrade, you see the 
following error message when you restart Component Manager:

Error Occurred in server thread; nested exception is: 

Java.lan.NoClassDefFoundError:filenet/vw/apps/taskman/VWTaskProcessLauncher

Solution: Restart the server.

Cannot viewing registered component classes in Process Configuration Console
Cause: The .jar file is not present on the client computer at the location specified when the 
component class was registered.

Solution: When you register a component class using Process Configuration Console, the .jar file 
must be accessible from your local computer during the configuration process. (You can copy 
the.jar file to a temporary folder on your local computer (for example, C:\Temp)). For runtime, the 
.jar file must be located on the Application Engine server where the Component Manager runs. 
You use the Task Manager to specify the exact location of the .jar file and to start the component. 

If you later use Process Configuration Console on a different computer to access the classes in 
this .jar file, an error will display if the .jar file is not present at the previously specified location on 
that computer. This does not necessarily indicate a problem in the configuration, since the 
requirement for runtime is that the .jar file be located on the Application Engine server where the 
Component Manager runs. To view the classes in the specified .jar file, you can either copy the 
.jar file to the directory on your local computer where Process Configuration Console expects to 
find it, or you can copy the .jar file to any location on your local system, then re-register the class. 
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Application Engine, Content Engine, and Process Engine

Connection fails
Cause: The connection between Process Engine and Content Engine for user and group security 
information does not work.

Solution: 

• Check the Windows Event Viewer, and look in the \fnsw\ logs (syslog, vwtrace file in fnsw_loc\sd or 
/fnsw/local/sd) for messages that explain the problem.

• Verify that the Process Engine is running.

– Enter the following command at the command line prompt:

– initfnsw status

– If the response does not include "Software started since…" Process Engine is not 
running. You can start Process Engine by entering the following command at the 
command line prompt:

initfnsw -y start

• Verify that the Process Engine is using port: 32776.

• (Window-based Process Engine servers only) Verify the Process Engine Services Manager is 
running. 

• Use the Services applet to verify that PESM is running. If it has not been started, then start it.

• Verify that the vwior process is running. (This process must be running so that the 
PEDirectoryServer process can communicate with Content Engine.) 

Open a web browser on the Process Engine server and enter the following URL. (If 
Process Engine is using a port other than 32776, adjust the port accordingly):

http://localhost:32776/IOR/ping

If the vwior process is running, you will see a response similar to the following sample 
response: 

Process Engine server

HQ-PE400 [Win32 Server Production (MS-SQL Blob 512 MB) -- {-rx-ux-nx} Jan 18 
2007 11:03:24 en ]

NOTE If the vwior process is not running, you might receive a response that indicates it is 
not running or you might receive no response at all. 

If the vwior process is not running, you need to determine why. Typically, it is because 
another program is using a socket that the vwior process requires. You can confirm this 
reason by checking the logs. Or, you can obtain the specific exception message that is 
recorded in the logs by trying to manually run the vwior process from the command line 
prompt. When the connection cannot be established, the exception message that is logged 
is also returned as the response.

To run the vwior process from the command line prompt, enter the following command:
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vwior -p 32776 -b 32777

If another application is using the socket required by the vwior process, restart the 
Process Engine server. Restarting the server causes the other application to release the 
socket. 

• Verify that the PEDirectoryServer Java service is running. (PEDirectoryServer is the Java service 
that provides the connection from Content Engine to Process Engine.)

Open a web browser on the Process Engine server and enter the following URL. (If 
Process Engine is using a port other than 32776, adjust the port accordingly):

http://localhost:32776/IOR/FileNet.CE.PEDirectoryServer

If the vwior process is running, you will see a response similar to the following sample 
response: 

IOR:000000000000002049444c3a46696c654e65745f63656d707270632f63656d707270633a
312e300000000001000000000000007e000102000000000c31302e31352e372e31303800071d
000000000031afabcb000000002084240cba00000001000000000000000100000008526f6f74
504f410000000008000000010000000014000000000000020000000100000018000000000501
00010000000000010109000000010001010000000026000000020002

NOTE If the PEDirectoryServer Java service is not running, you might receive a 
response that indicates it is not running or you might receive no response at all. 

You can also verify the PEDirectoryServer Java service is running by checking the logs. 

If you see the following message (initiation string) listed only once, it indicates the 
PEDirectoryServer Java service is running. However, if you see the message listed more 
than once, it indicates the PEDirectoryServer Java service tries to start but fails:

VW: PEDirectoryServer start command: C:\fnsw\jre\bin\java -Xmx128M -Xrs -cp 
C:\fnsw\bin\pe.jar;C:\fnsw\CE_API\lib\Jace.jar;C:\fnsw\CE_API\lib\log4j.jar;C:\fnsw\CE
_API\wsi\lib\wasp.jar -
Djava.security.auth.login.config=C:\fnsw\CE_API\config\jaas.conf.WSI -
Dwasp.location=C:\fnsw\CE_API\wsi filenet.pe.ceorb.server.PEDirectoryServer /
port=32776

You can obtain exception information by manually running the PEDirectoryServer Java 
service from the command line prompt. When the connection cannot be established, an 
exception message is returned, which might explain why the PEDiretoryServer cannot 
start. 

To run the PEDirectoryServer Java service from the command line prompt, copy the 
initiation string (preceding message) from the logs and enter it as the command.

• Verify that the jaas.conf.WSDI file is present. 

• Verify that the Jace.jar file is located in the \fnsw\CE_API\lib2 directory on the Process Engine 
server. 

Verify that this Jace.jar file is the same as the Jace.jar file being used on the Content 
Engine server. If it is not, copy the file from the Content Engine server and place it in the 
\fnsw\CE_API\lib2 directory on the Process Engine server. 

• Verify that the Process Engine server can see the Content Engine server.

Ping the Content Engine server from the Process Engine server.

NOTE Use the hostname of your Content Engine server in place of your-ce-server.
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WebSphere 

Open a web browser on the Process Engine server and enter the following URL:

http://your-ce-server:9090/admin

WebLogic

Open a web browser on the Process Engine server and enter the following URL:

http://your-ce-server:7001/admin 

• Verify that the basic Process Engine security configuration is correct.

Check the user name and service password (as specified on the Security tab of the 
Process Task Manager).

Verify that the security user name is a member of the administrator group (also specified 
on the 
Security tab of the Process Task Manager).

• On the Content Engine application server, verify the authentication providers are correct. 

Verify that the built-in authentication provider is not configured as “Required”. Any 
authentication provider that is configured as “Required” requires all user who will 
authenticate be defined in that provider. 

• Enable Java tracing to see what happens when the PEDirectoryServer tries to communicate with 
Content Engine.

Windows

Locate the fnsw_loc\sd\fnlogging.properties.sample file on the Process Engine server. 

Copy the fnlogging.properties.sample file in to the \fnsw\jre\lib directory on the Process 
Engine server and rename it to fnlogging.properties. 

When this file is present in the directory, additional trace information will be written to a file 
called c:\PEServerJavaTrace%g.txt where the %g value in the file name is replaced with 
an integer (probably a zero).

After attaining Java log information, disable Java tracing by renaming the file.

UNIX

Locate the \fnsw\local\sd\fnlogging.properties.sample file on the Process Engine server. 

Copy the fnlogging.properties.sample file in to the \fnsw\jre\lib directory on the Process 
Engine server and rename it to fnlogging.properties. 

When this file is present in the directory, additional trace information will be written to a file 
called c:\PEServerJavaTrace%u.txt where the %u value in the file name is replaced with 
an integer (probably a zero).

Remove the leading “#” character from the following line:

#filenet.vw.base.logging.FileHandler.pattern = %h/PEServerJavaTrace%u.log

Comment out the “Windows” trace file name by adding a leading “#” character to the 
following line:

filenet.vw.base.logging.FileHandler.pattern = %h/PEServerJavaTrace%g.txt

After attaining Java log information, disable Java tracing by renaming the file.
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Cannot delete a security policy from a large object store 
If deleting a security policy takes longer than 60 seconds, you might encounter a DTC transaction 
timeout. This results in the error “The root transaction wanted to commit, but transaction aborted.” 
This error might occur while using either Enterprise Manager or Workplace.

Cause: Due to the size of the database, the transaction has timed out. (Timeout might occur 
regardless of database type.)

Solution: The Database Administrator should perform the following on the database:

1. Confirm that there are a large number of rows in the docversion table.

2. If so, create the following index:

CREATE INDEX I_DocVersion_01 ON DocVersion (security_policy_id)

NOTE The index name is arbitrary but must not conflict with the scheme used for Content 
Engine indexes (which is without the underscore before the digits at the end), and must obey 
length limits.

3. If there are also many thousands of rows in the Container and Generic tables, then also create 
an index on the security_policy_id column of those tables. For example: 

CREATE INDEX I_Container_01 ON Container (security_policy_id)

CREATE INDEX I_Generic_01 ON Generic (security_policy_id)

Security permissions fail to import successfully
Cause: Security permissions can be included in an XML-based export definition by selecting 
"Export Security Permissions" while running the Export Options tool. If you attempt to import 
permissions that were exported from an object store in a FileNet P8 domain that uses 
authentication database A, into an object store in another FileNet P8 domain that uses 
authentication database B, then the security permissions will not import successfully unless 
authentication database B has the same user and group accounts as those in authentication 
database A. 

Solution: Use the Security Map Wizard to map the accounts from authentication database A to 
authentication database B. Keep in mind that during the mapping process, you cannot change the 
authentication provider type. For example: attempting to map a Sun Java system directory server 
account to an Active Directory account will fail.

Queries for users and groups time out before returning results
(Active Directory only) Querying the authentication provider for user and group accounts takes 
place while running the Content Engine installation program (to specify GCD administrative 
accounts), while running the object store wizard (to specify object store administrators and object 
store default users), and whenever you need to add new accounts to existing objects (when you 
click Add from any securable object's security page). The results of the query are available for 
selecting and adding to the object's list of permissions. This query, based on your input, is sent by 
Content Engine to the Active Directory which processes it. If the query result is a large matching 
set, it could take more time to return than is allowed by the Windows LDAP policies. The query will 
time out and you will be informed of the timeout by Enterprise Manager or Content Engine 
installation program, depending on which you are using.

Solution: Re-issue the query using more refined criteria (smaller maximum results number or a 
more specific search pattern) so that it takes less time to process, or use the tools that are 
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available to increase the Windows LDAP timeout policy. This will affect any other applications 
using Active Directory. Contact your directory administrator for assistance.

Renaming a user while using Windows non-local authentication 
causes errors
When the FileNet P8 domain is configured to use a Windows Active Directory-based 
authentication realm in a Windows domain that is different from the Windows domain containing 
the Content Engine installation, and when the security administrator changes a user name, 
Enterprise Manager or other client capable of displaying FileNet P8 security throws errors and 
cannot display the account's name. This is a Windows error, described in full detail in the 
Microsoft Knowledge Base Article - 329420, “The LookupAccountSid Function Returns the Wrong 
Name After You Rename Accounts,” and is related to the Service Pack level of the machine. 

Solution: Restart Enterprise Manager or other client application. This will cause the client to go 
back to the Domain Controller for the new user names, and update the local client credentials 
cache.

How to change LDAP shortname in Process Engine if dn remains the 
same
Duplicate shortnames can potentially disrupt Process Engine work items. If a user’s LDAP 
shortname has been changed while maintaining the dn, use the following procedure to 
synchronize the user’s shortname stored in Process Engine database with the new shortname 
stored in LDAP.

To synchronize Process Engine shortname with LDAP shortname

1. Find all of the active work items that are associated with the old shortname of the user, referred 
to here as UserA.

2. Make sure that UserA is not assigned as an “Out of Office” for another user:

a. View all environment records (vwtool -> env -> view -> persistent -> *)

b. Check the F_ProxyId field.

c. If UserA has been assigned as an “Out of Office” for another user, log in to Workplace as an 
admin user (not as UserA), and change the Out of Office setting to some other user account.

3. Temporarily assign all of UserA's work items to another user, referred to here as User B.

4. In the LDAP directory, change UserA’s shortname so that it is unique.

5. Run vwtool > env > fixup > single to change UserA’s old shortname to UserA’s new 
shortname.

Since work items are tied to users by means of the indirect user ID, the effect of this step is to 
relink the ID to the new shortname. The application will display work items using UserA’s new 
shortname. 

6. Reassign work items from UserB back to UserA.

7. Flush the cache.

8. Because this procedure only fixes Process Engine work items, you will also have to change any 
instances of UserA’s old shortname that still exist in Workflow definitions stored in external 
datasource.
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For related changes such as moving a user from one OU to another OU in the domain tree; 
moving a user from one group to another group; or changing the email for a user: you should use 
fixup->multiple, since these operations do not require changing the short name. The command 
fixup->single is used only to adjust a short name. Remember to flush the cache after any 
changes.

Windows’ Data Execution Prevention feature prevents BPM-
related Java processes from running
Data Execution Prevention (DEP) is a feature introduced in Windows Server 2003 with Service 
Pack 1, and is designed to help prevent malicious programs from executing. However, it appears 
that by default it prevents all BPM-related Java processes from starting after the system was 
rebooted.

This feature could potentially be set by an IT department and unexpectedly prevent IBM FileNet 
P8 BPM and other processes from executing.

For an explanation of DEP and how to manually configure it, see the Microsoft Technet article 
http://technet.microsoft.com/en-us/library/cc738483.aspx. According to the article, “The majority 
of applications will not encounter a problem with DEP. However, when an application does 
encounter a problem with DEP, a Data Execution Prevention message is presented to the user, 
alerting them to the problem.” 

The article explains how to configure DEP settings. While you should carefully choose how best to 
configure DEP in collaboration with your own IT department, IBM FileNet in-house testing 
indicates that you can re-enable BPM Java process by choosing the setting “Turn on DEP for 
essential Windows programs and services only”.
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Content Services (CFS-CS) and IICE (CFS-IICE)

Document federation

Resolving deadlock errors when federating large quantities of documents
Cause: When federating large quantities of documents, you might receive the following error:

ERROR - Unable to retrieve batch id='E8B1739C-FF4B-8B4B-9150-82BB21B54FA5'

com.filenet.cfs.iice.federator.exception.DataAccessException: 
com.microsoft.sqlserver.jdbc.SQLServerException: Transaction (Process ID 59) was 
deadlocked on lock resources with another process and has been chosen as the deadlock 
victim. Rerun the transaction.

Caused by:

com.microsoft.sqlserver.jdbc.SQLServerException: Transaction (Process ID 59) was 
deadlocked on lock resources with another process and has been chosen as the deadlock 
victim. Rerun the transaction.

Solutions:

• Use a smaller JVM heap size for the RMI Bridge.

• Reduce the batchsize value using the CFS Administrator tool.

Mimetype for a federated document is incorrect
Solution: Create a new version of the document in the external repository with the correct mime 
type. The next time the rule is run, the updated document will be detected, and the mime type of 
the new version will be applied to the federated document.

Import and Export

Content Services export errors
Cause: By default, CS can process up to 10 simultaneous library requests, and a single 
federation rule might need more than 10 threads for processing. 

Solution: Increase the number of simultaneous library requests.

1. On the CS server, select Start > Programs > FileNet > IDM > Configure.

2. Click Additional Preferences.

3. Locate the desired CS library and select Libraries.

4. Change the value for Active Requests per User to a larger number, such as 20. 

5. Restart the RMI bridge.

6. Rerun the federation rule.
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Import error is not cleared when rule is rescheduled
Cause: If there is an import error (such as due to a federated item being versioned), this error is 
logged, as expected. However, when the rule is rescheduled, the error is not cleared.

If there is an import error, the Rule Management page in the Federation Administrator indicates 
that an error occurred. If you modify the import rule as part of the process of resolving the import 
error, then the error is cleared from the Rule Management page. 

If the error is resolved without editing the rule (for example, by adding or modifying a property in 
Content Engine), then the import rule has not been changed. Re-running the same import rule 
might succeed because the problem was fixed, but the error is still indicated in the Rule 
Management page. 

Solution:

1. In the Rule Management page, click Edit to edit the rule with the error.

2. Click Apply. You do not need to make any changes. 

3. Rerun the rule.

Mapping the Date Last Modified property
You can use the Content Engine Date Last Modified property to determine if property updates 
(import request) have been applied to an existing federated document by mapping the Date Last 
Modified property to the external document revision date property.

If these properties are mapped, then when a federation rule is run, the revision date in the 
external repository is compared to the existing Date Last Modified value in the Content Engine for 
the existing document. Based on the comparison, one of the following actions occurs:

• If the Date Last Modified (Content Engine) is more recent, then the properties are not updated. For 
example, if the federated document has been updated more recently via a FileNet P8 application, 
then updates from the external repository are ignored.

• If the revision date (external) is more recent, then the properties are updated and the revision date 
value is copied into the Date Last Modified property on the federated Document.

If the Date Last Modified is not mapped to the revision date, then the property updates are applied 
always.

Fixed storage area issues
• A fixed storage area is required in order to import federated documents. Make sure that after you 

create the IICE Fixed Content Device, you create an associated fixed storage area.

• Although the content element counters of the fixed storage area are not incremented when 
federated documents are created, there are transient counters within the server that are updated 
during federated document creation. Since the maximum number of elements for a fixed storage 
area is low by default (2500), it is possible to exceed this value while importing federated 
documents, causing the area to be marked ‘full’. Once the area is marked full, all import requests 
fail. Adding another fixed storage area does not solve the problem, since only the first area is used 
by the importer. To avoid this problem, be sure to set the maximum number of elements to a size 
commensurate with your expected federation rates when creating the fixed storage area.
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Monitoring the progress of the CFS Import Agent
You can use the PCH counters in FileNet Dashboard to monitor the progress of the CFS Import 
Agent. These counters provide a detailed view into the operation of the Importer, which executes 
as a background task within a Content Engine server instance.

The counters are located under User > Server Based Counters > CFS Import Agent > 
IICE_Fixed_Content_Device_Name.

NOTE The counters are for a named IICE fixed content device, for a specific instance of the 
Content Engine server.

The PCH counters are divided into the following groupings:

• Progress: Federated documents created, checked in, checked out, updated, and loaded.

• Database Activity: Rows selected, inserted, updated, and deleted by table: cfs_imp_session, 
cfs_imp_queue, fdb_version_series

• Exceptions: Rejected requests, expired requests (returned to queue), and obsolete requests.

Import fails when attempting to create a second version of a federated document
Cause: If a Content Engine document property is defined as both ‘required’ and ‘not copied to 
reservation’, then the Importer fails when it attempts to create a second version of a federated 
document because the document checkout fails. The request remains in the queue, and is retried 
indefinitely. 

Solution: Change the property definition to be either not required, or make it copied to 
reservation. Once the change is made, the next time the Importer retries the request, the new 
federated version will be created.

E_OBJECT_MODIFIED error
An object modified error might be generated when an attempt is made to import a new document 
with multiple versions and file it in a folder. The error can be ignored as the request will be retried 
automatically.

Importer error codes
The Importer writes invalid requests to an error table (cfs_imp_queue_error). The error table 
contains the full request, plus an error code and an a description of the error (error_context 
column). Use this information when troubleshooting import failures. For a complete list, see 
.“Import errors” on page 85
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE



 Content Federation Services
Image Services (CFS-IS)

53
Image Services (CFS-IS)

Network connections

IP address for IS connection is not propagated to Content Engine application server
Cause: When an IP address for the IS library is edited in the hosts file or via a name resolution 
service, such as Domain Name Service (DNS), or Network Information Service (NIS), the change 
is not detected by the Content Engine. For example, attempting to create a Fixed Content Device 
for the CFS-IS connection fails with an error message that lists the old IP address value.

Solution: Restart the Content Engine application server after changing the address.

Does IS limit the number of concurrent FileNet P8 users accessing documents 
Yes. Content Engine uses a single userid (specified on the IMFixedContentDevice) to connect to 
the IS server. IS has a maximum session count of 512 per userid. So this effectively limits the 
number of concurrent accesses to documents stored on IS to 512.

You can monitor the number of current sessions on the IS server by using sec_tool and the who 
command.

Why does my custom application take up so many Image Services sessions?
Make sure your custom application is explicitly closing the InputStream after retrieving the 
content. If the InputStream is not closed, it can take up to 30 seconds before the Content Engine 
recognizes the change and closes the connection automatically.

How many IS sessions do the IS import agents use?
There are 2 IS sessions per IS import agent configured. One of the IS sessions is for federating 
documents. The other is used to federate annotations.

Document federation

Where are federated IS Annotations stored in the Content Engine?
Unlike federated documents, the federated annotations from IS are copied into Content Engine. 
However, the storage area used for IS annotations vary according to the version of Content 
Engine.

• For P8CE 4.0.1 FP001 and earlier, IS Annotations are always stored in the first fixed storage area 
created that references the IS fixed content device. This storage location cannot be changed, even 
if that storage area is closed due to reaching it's storage area maximums. The only thing that can 
be done in this case is add more disk space to accommodate the expected size of the IS 
annotations.

• For P8CE 4.0.1 FP002, multiple fixed storage areas can be defined that point to the same IS fixed 
content device. Thus, if one fixed storage area becomes full, another one is automatically chosen 
to store the content for the IS annotation.

• For P8CE 4.0.1 F00P3 and later, the IS Annotation storage will depend on the storage policy set 
on the ISAnnotation class. The annotations can be stored in any storage area you choose, 
depending on the storage policy.
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Can I delete federated IS annotations from a FileNet P8 Platform application?
You can delete federated IS annotations by using one of the following methods:

• Delete the annotation in the IS client application (IDM Viewer). The delete request will be 
propagated to the Content Engine.

• Use Enterprise Manager to locate and delete the annotation. Search for objects with the class 
"ISAnnotation" and descriptive text similar to the following:

"<CFS-IS Document number Page n”

where:

number is the IS document ID

n is the page number where the annotation is located

For example, “<CFS-IS Document 100178 Page 1” 

• Create a custom FileNet P8 application that can access and delete the annotation. The delete 
request will be propagated to IS. Currently, Image Viewer does not allow federated annotations to 
be deleted.

Images federated from CFS-IS do not display properly in Image Viewer
Cause: A Workplace configuration setting has not been updated for CFS-IS.

Solution: 

1. With a text editor, open install_dir/FileNet/AE/Workplace/UI-INF/jsp/ui/WcmJavaViewer.jsp.

2. Find the following line, and change the "true" value to "false":

writeParam('filenetAlwaysRubberband', 'true' );

3. Save and close WcmJavaViewer.jsp.

4. If Application Engine is deployed as an EAR or a WAR, redeploy it with the updated 
WcmJavaViewer.jsp.

How large are IS annotations?

Annotations are stored in a binary format that has a maximum size of 800 bytes. When they are 
federated into Content Engine, they are translated into an XML format with a maximum size 
between 2-3 KBs.

How do I transfer my IS document class mapping from one object store to another?
You might need to move from a development object store to a production object store. 

1. Use Enterprise Manager to export the document classes used in the IS mapping from the 
original object store.

a. Select the Content Engine document class that is used in the IS mapping.

b. Right-click the document class name, and select All Tasks > Add to Export Manifest.

NOTE Depending on your data, select Add to Export Manifest (include sub classes), if 
necessary.

c. From Include Options, select Include all associated objects.
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NOTE Review your data to determine if this is the appropriate selection depending on the 
document class being exported.

If necessary, choose Select associated object to include manually, and then select the 
appropriate options.

– If selecting options manually, make sure you select Include property templates on 
classes and Include choice lists on property templates.

d. Repeat steps a-c for each Content Engine document class that is used in the IS mapping.

2. Select the Export Manifest folder.

3. Right-click, and select Export All Objects.

4. From Export Options, set the following:

a. Set the Export File Location directory.

b. Set the Log File location.

c. Depending on your data, determine if a other Export Option defaults need to be changed.

5. Use Enterprise Manager to import the Content Engine doc classes used in IS mapping into the 
new object store.

a. Select the new object store.

b. Right-click the object store name, and select All Tasks > Import All.

c. From the Import Helper:

i. From the Import Manifest File field,select an export manifest file 

NOTE If you changed the file locations between export and import, you will need to 
manually update the file paths in the manifest file.

ii. Set the Log File location.

iii. Make sure that Import Object ID is selected (default setting).

iv. Depending on your data, determine if other Import Option defaults need to be changed.

6. Copy the mapping XML from the custom object in the original object store.

a. In the original object store, open the Search Results node and start a new search.

b. From the Select from Table dropdown list, select the ISMappingCustomObject class, and 
then execute the search. There should be one object found.

c. Get the properties on the object.

d. Display or edit the property DocClassAndPropertyMappingXML. 

e. Copy the text.

7. Paste the mapping XML for the custom object in the new object store.

a. In the new object store, open the Search Results node and start a new search.

b. From the Select from Table dropdown list, select the ISMappingCustomObject class, and 
then execute the search. One object should be found.

c. Get the properties on the object.

d. Display/Edit the property DocClassAndPropertyMappingXML. 
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e. Paste the text that you copied earlier, overwriting the existing value.

f. Save the changes to the custom object. Saving will also update the IS server.
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Records Manager

General

The RMBaseURL can become outdated when the RM URL changes
Cause: The RMBaseURL can become outdated when the RM URL changes. The most common 
reason for this URL to become outdated is if the hostname of the original RM server changes.  
When this occurs, links that refer to the RM server fail when Workplace redirects the HTTP 
requests to the RM URL. The RMBaseURL is a key in the Workplace Site Preferences XML file 
that is stored in the Content Engine. This URL tells Workplace where to find send RM GUI 
requests. This URL gets set once, when the RM application is launched and you login for the first 
time.

You will notice this issue, for example, when you select Get Info for a document version that has 
been declared as a record since Workplace information pages include a Record Properties view. 
When you click the Record Information Get Info button, the browser is not be able to open the 
page.

At this time there is no GUI-based mechanism to update this URL.

Solution: To correct the problem, update the RMBaseURL setting in the Site Preferences XML file 
manually using Enterprise Manager. Then, restart the Records Manager application server.

New WSI retry configuration option
Cause: When you are running the RM Hold Sweep tool or the RM Disposition Sweep tool with the 
multi-thread option, you might receive the following WSI error in the activity log:

WSI Failure - invalid format for header value UsernameToken/BinarySecurityToken. Format 
should be non-null.

This is only realized when running the sweep tools with the multi-thread option. Running the tools 
with the single thread option does not return the error.

NOTE WSI is a public programming interface supported by P8 Content Engine.

Solution: This error can be eliminated by manually editing the configuration files of the two sweep 
tools (RMSweepConfiguration.xml for the RM Disposition Sweep tool and 
RMHoldSweepConfiguration.xml for the RM Hold Sweep tool). Add the following string to the files:

<WSI_RETRY_COUNT>10</WSI_RETRY_COUNT>

After manually adding the option, the impacted area of the configuration files should look as 
follows:

....<READ_BATCH_SIZE>10000</READ_BATCH_SIZE><WSI_RETRY_COUNT>10</
WSI_RETRY_COUNT><SWEEP_STOP>false</SWEEP_STOP>.....

Once you have the option in the configuration file, you can edit the file and change the count to 
more than 10 or some other number you determine.

Please note the following items concerning the retry value:

• If this option is not specified in the tools' configuration files, the default retry count will always be 
10. 

• The minimum value for the retry count is 10, and can only be manually changed to a higher value.
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• When running Sweep configure, even though the option does not show up in the UI, the tools write 
it to their configuration file with the default value if it's not there. But if the option already exists, it is 
preserved.

• If the retry entry is not in the config file, you can either run Sweep with the configure option which 
automatically adds the entry or manually edit the file.

• If anything less than 10 is specified, it will be ignored and the default of 10 retries will be used.

Corrupted entities if Hold Sweep is terminated in the middle of its run
Cause: If a Hold Sweep is abnormally terminated or is shut down in the middle of its run, some 
entities can be left in an abnormal state. Examples:

• A HOLD can become corrupted. From the Records Manager UI, the entity no longer has the flag 
for a dynamic hold to "Activate for Sweep processing" or "Initiate Hold Removal". When running 
Hold Sweep, the entity is not changed, even when using the ForceRemoveHold option.

• The Entities on Hold stay forever on Hold. This occurs because the entities are in a dynamic Hold 
and cannot be removed by hand or by running sweep because the Hold does not respond to the 
sweep process.

• Entities show up in the "Entities on Hold" list of the Hold. In the properties page of the entities, the 
Hold name shows up, but from the user interface, there is no icon indicating that the entity is on 
hold.  This is because the link was not fully created

Solution: To recover, complete the following steps:

1. Log in to Enterprise Manager and expand the FPOS.

2. Perform a Search for the Record Hold class by right-clicking on the object store name and 
selecting Search. In the Select From Table menu, select Record Hold, and click OK.  Click Yes 
and click OK. The list of Record Holds displays.

3. Right-click on the Hold that is broken and select Properties.

4. Click the Properties tab and click All Properties.

5. Find the property called Sweep State and set its value to 3. Click OK.

6. Refresh the Object Store.

7. Log in to the RM Application using the browser, and right-click on the "corrupted" hold. It should 
now have an Activate for Hold Sweep Processing menu item.

8. Click on the Activate for Hold Sweep Processing menu item.

9. On the machine where HoldSweep is installed, run Hold Sweep. The entity on Hold should be 
processed.
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File Plan Import and Export Tool
This section includes information about the common causes of errors that you might encounter 
when using the File Plan Import Export Tool. Also, this section discusses how to reduce the 
likelihood of encountering errors.

Common causes of errors
In most cases, the import process stops after encountering an error, and does not display any 
message. The cause of the error might be any of the following:

• Custom classes and properties were not imported before the file plan. 

• The XML file used for the import process is not a compatible format, such as RTF.

• The XML file is not compliant with the XML standard, or is not compatible with the IBM FileNet 
XML schema model.

• There are business logic errors in the XML file.

The File Plan Import Export Tool includes options that you can use to address potential errors. 
These options are discussed in the sections that follow.

Manually creating a compliant XML file
Most of the errors that occur while importing a file plan are caused by incompatible or non-
compliant XML files. Before you can import a file plan, you must create an XML file that is both 
compliant with the XML standard and compatible with FileNet's XML schema.

For the purposes of discussion, manually creating an XML file refers to creating an XML file by 
means other than the File Plan Import Export Tool. For example, you can use macros or other 
programmatic means to create an XML file. 

If you manually create an XML file to use in importing a file plan, you must base the file on the 
XML schema provided by IBM. Details about the XML schema are provided in the File Plan XML 
Schema help topic in the Developer Roadmap. 

After you manually create an XML file, you should run the File Plan Import Export Tool in validate 
mode to verify that the file does not contain any errors or non-compliance issues. See "Validating 
a file plan" in the Records Manager help topic, FileNet P8 Documentation > Expansion Products > 
Records Manager > File Plans > How to > Use the File Plan Import Export Tool. 

For more information on the options that are available when you manually create an XML file, see 
“Subcategory schedule inheritance” on page 60 and “ConditionXML property” on page 61.

Observing the File Plan Import Export Tool functionality
If you intend to manually create an XML file to import a large file plan with custom classes and 
objects, a good practice is first creating a small file plan and related metadata, and then executing 
the tool in export mode. Such a practice is useful before you manually create an XML file for file 
plans with conditional holds, internal event triggers, and alternate retention objects, all of which 
contain the complex conditionXML property. Even though you create a file with the correct XML 
format, the XML file might have incorrect property values or syntax, which can cause an error 
during importation. Exporting a small file plan enables you to review the XML file that the tool 
created, and to observe the syntax and property values in the XML file. 
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Subcategory schedule inheritance 
When you create a subcategory, you can use the Record Manager user interface to specify that 
the subcategory inherits the parent disposition schedule. If you manually create the XML file to 
import the file plan in which the subcategory is contained, you have an option to specify that the 
subcategory does not inherit the parent's schedule and provide a different schedule. 

In the XML file you create, use the DisposalScheduleInheritedFrom property to indicate whether 
the record category inherits the disposal schedule from the parent. For example: 

<RecordCategory Name="myCat2" Level="2" ParentPath="/myCat1">

<Properties>

        <Property Name="AGGREGATION" Value="RecordCategory" /> 

        <Property Name="IsPermanentRecord" Value="false" /> 

        <Property Name="IsVitalRecord" Value="false" /> 

        <Property Name="CurrentPhaseExportFormat"></Property> 

        <Property Name="IsDeleted" Value="false" /> 

        <Property Name="HomeLocation"></Property> 

        <Property Name="VitalRecordReviewAction"></Property> 

        <Property Name="IncrementedBy" Value="1" /> 

        <Property Name="RecordCategoryName" Value="myCat2" /> 

        <Property Name="DisposalScheduleInheritedFrom" Value="/myCat1" /> 

        <Property Name="Reviewer" Value="ylin" /> 

        <Property Name="RecordCategoryIdentifier" Value="myCat2" /> 

        <Property Name="VitalRecordDisposalTrigger"></Property> 

        <Property Name="Inactive" Value="false" /> 

        <Property Name="Location"></Property> 

        <Property Name="DateOpened" Value="2006-03-07T14:16:00-08:00" /> 

        <Property Name="DisposalSchedule">

                <ObjectRef ClassId="DisposalSchedule" ObjectId="myDispSchedule" /> 

        </Property> 

    </Properties> 

</RecordCategory> 

You can use the DisposalScheduleInheritedFrom property in the following four scenarios:

• Use the parent path for the property value of DisposalScheduleInheritedFrom, for example: 

<Property Name="DisposalScheduleInheritedFrom" Value="/myCat1" /> 

• When the DisposalScheduleInheritedFrom property is not provided in the XML file, the property 
value will not be set and there is no disposal schedule inheritance for this container. 

• When the parent path is provided for DisposalScheduleInheritedFrom property and the 
DisposalSchedule property is not provided in the XML file, the parent's disposal schedule will be 
inherited. 

• The DisposalSchedule property is set to the parent's disposal schedule and the 
DisposalScheduleInheritedFrom property will be set to the parent's GUID. 
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• If the parent does not have a disposal schedule, the item will not be processed and a skip 
message will be logged to the activities log. 

• If the parent path provided for DisposalScheduleInheritedFrom property does not match with the 
ParentPath attribute of the RecordCategory, the item will not be processed and a skip message 
will be logged to the activities log. 

• When both DisposalScheduleInheritedFrom and DisposalSchedule properties are provided:

• If the DisposalSchedule provided does not match the parent disposal schedule, the item will not be 
processed and a skip and error message will be logged to the activities log. 

• If the parent does not have a disposal schedule, the item will not be processed and a skip 
message will be logged to the activities log.

ConditionXML property
When you manually create an XML file to import a file plan, you have the option of specifying 
values for the ConditionXML property, which the file plan import tool uses to import the following:

• Alternate Retentions

• Internal Event Triggers

• Dynamic Holds (the term "conditional hold" is used in Help topics) 

For Alternate Retentions, Internal Event Triggers and Dynamic (conditional) Holds entities, the 
ConditionXML property stores search conditions in XML format. The properties tag in 
ConditionXML stores the property name/value/operator for the RM user interface. The sql tag in 
ConditionXML stores the SQL statement. When you enter the property value of ConditionXML for 
file plan import, the special characters (< > & " ') need to be converted to the standard 
representation (&lt; &gt; &amp; &quot; &apos;). 

Below are sample XMLs of entities containing the ConditionXML property for the File Plan Import 
Export tool.

Sample of ConditionXML for Alternate Retention
<Phases>

  <RMEntity Type="Phase" Name="myPhase1">

    <Properties>

      <Property Name="PhaseAction"></Property>

      <Property Name="RetentionPeriodDays" Value="0" />

      <Property Name="RetentionPeriodYears" Value="10" />

      <Property Name="RMEntityDescription" Value="my phase 1" />

      <Property Name="RetentionPeriodMonths" Value="0" />

      <Property Name="PhaseNumber" Value="1" />

      <Property Name="ExportFormat"></Property>

      <Property Name="IsScreeningRequired" Value="true" />

      <Property Name="DisposalSchedulePtr">

        <ObjectRef ClassId="DisposalSchedule" ObjectId="myDispSchedule" />

      </Property>

      <Property Name="PhaseName" Value="myPhase1" />
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      <Property Name="AlternateRetentions">

        <ObjectValue Type="AlternateRetention">

          <Properties>

            <Property Name="RetentionBase" Value="CutoffDate" />

            <Property Name="ConditionXML" Value="&lt;response xmlns=&quot;http://
filenet.com/namespaces/wcm/apps/1.0&quot;&gt;&lt;objectset&gt;&lt;count&gt;1&lt;/
count&gt;&lt;customobject&gt;&lt;properties&gt;&lt;property&gt;&lt;symname&gt;ClosedBy
&lt;/symname&gt;&lt;operator&gt;IS EQUAL&lt;/
operator&gt;&lt;value&gt;Administrator&lt;/value&gt;&lt;/property&gt;&lt;/
properties&gt;&lt;aggregation&gt;&lt;/aggregation&gt;&lt;sql&gt; AND ([ClosedBy] = 
&apos;Administrator&apos;)&lt;/sql&gt; &lt;/customobject&gt;&lt;/objectset&gt;&lt;/
response&gt;" />

            <Property Name="RetentionPeriodMonths" Value="0" />

            <Property Name="RetentionPeriodYears" Value="5" />

            <Property Name="RetentionPeriodDays" Value="0" />

          </Properties>

        </ObjectValue>

        <ObjectValue Type="AlternateRetention">

          <Properties>

            <Property Name="RetentionBase" Value="DateClosed" />

            <Property Name="ConditionXML" Value="&lt;response xmlns=&quot;http://
filenet.com/namespaces/wcm/apps/1.0&quot;&gt;&lt;objectset&gt;&lt;count&gt;1&lt;/
count&gt;&lt;customobject&gt;&lt;properties&gt;&lt;property&gt;&lt;symname&gt;RMEntity
Description&lt;/symname&gt;&lt;operator&gt;LIKE&lt;/
operator&gt;&lt;value&gt;something&lt;/value&gt;&lt;/property&gt;&lt;/
properties&gt;&lt;aggregation&gt;&lt;/aggregation&gt;&lt;sql&gt; AND 
([RMEntityDescription] LIKE &apos;%something%&apos;)&lt;/sql&gt; &lt;/
customobject&gt;&lt;/objectset&gt;&lt;/response&gt;" />

            <Property Name="RetentionPeriodMonths" Value="0" />

            <Property Name="RetentionPeriodYears" Value="5" />

            <Property Name="RetentionPeriodDays" Value="0" />

          </Properties>

        </ObjectValue>

      </Property>

    </Properties>

  </RMEntity>

</Phases>

Sample of Disposal Trigger with ConditionXML
<DisposalTriggers>

    <RMEntity Type="DisposalTrigger" Name="Date Created">

       <Properties>

           <Property Name="DisposalTriggerName" Value="Date Created" />

           <Property Name="EventType" Value="3" />
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           <Property Name="CycleYears" Value="0" />

           <Property Name="CycleDays" Value="0" />

           <Property Name="AGGREGATION" Value="RecordInfo" />

           <Property Name="ConditionXML" Value="&lt;response xmlns=&quot;http://
filenet.com/namespaces/wcm/apps/1.0&quot;&gt;&lt;objectset&gt;&lt;count&gt;1&lt;/
count&gt;&lt;customobject&gt;&lt;properties&gt;&lt;property&gt;&lt;symname&gt;DateCrea
ted&lt;/symname&gt;&lt;displayname&gt;Date Created&lt;/
displayname&gt;&lt;propertytype&gt;3&lt;/propertytype&gt;&lt;value/
&gt;&lt;operator&gt;IS NOT NULL&lt;/operator&gt;&lt;jointype&gt;AND&lt;/
jointype&gt;&lt;/property&gt;&lt;/properties&gt;&lt;aggregation&gt;RecordInfo&lt;/
aggregation&gt;&lt;sql&gt; SELECT OIID , ID , RMENTITYTYPE FROM RecordInfo WHERE ( 
DateCreated IS NOT NULL )&lt;/sql&gt;&lt;/customobject&gt;&lt;/objectset&gt;&lt;/
response&gt;" />

           <Property Name="CycleMonths" Value="0" />

       </Properties>

    </RMEntity>

</DisposalTriggers>

Sample of Dynamic Hold with ConditionXML
<Holds>

    <RMEntity Type="RecordHold" Name="dynamic Hold">

       <Properties>

           <Property Name="Active" Value="true" />

           <Property Name="HoldName" Value="dynamic Hold" />

           <Property Name="HoldReason" Value="dynamic Hold" />

           <Property Name="ConditionXML" Value="&lt;response xmlns=&quot;http://
filenet.com/namespaces/wcm/apps/1.0&quot;&gt;&lt;objectset&gt;&lt;count&gt;2&lt;/
count&gt;&lt;customobject&gt;&lt;properties&gt;&lt;property&gt;&lt;symname&gt;RecordCa
tegoryName&lt;/symname&gt;&lt;displayname&gt;Record Category Name&lt;/
displayname&gt;&lt;propertytype&gt;8&lt;/propertytype&gt;&lt;selectable&gt;true&lt;/
selectable&gt;&lt;value&gt;dynamic&lt;/value&gt;&lt;operator&gt;like&lt;/
operator&gt;&lt;jointype&gt;AND&lt;/jointype&gt;&lt;/property&gt;&lt;/
properties&gt;&lt;aggregation&gt;RecordCategory&lt;/aggregation&gt;&lt;sql&gt; SELECT 
ro.[RecordCategoryName] , ro.[RecordCategoryName] FROM RecordCategory ro Where 
ro.[RecordCategoryName] like &apos;%dynamic%&apos; &lt;/sql&gt;&lt;/
customobject&gt;&lt;customobject&gt;&lt;properties&gt;&lt;property&gt;&lt;symname&gt;R
ecordFolderName&lt;/symname&gt;&lt;displayname&gt;Record Folder Name&lt;/
displayname&gt;&lt;propertytype&gt;8&lt;/propertytype&gt;&lt;selectable&gt;true&lt;/
selectable&gt;&lt;value&gt;dynamic&lt;/value&gt;&lt;operator&gt;like&lt;/
operator&gt;&lt;jointype&gt;AND&lt;/jointype&gt;&lt;/property&gt;&lt;/
properties&gt;&lt;aggregation&gt;RecordFolder&lt;/aggregation&gt;&lt;sql&gt; SELECT 
ro.[RecordFolderName] , ro.[RecordFolderName] FROM RecordFolder ro Where 
ro.[RecordFolderName] like &apos;%dynamic%&apos; &lt;/sql&gt;&lt;/customobject&gt;&lt;/
objectset&gt;&lt;/response&gt;" />

           <Property Name="HoldType" Value="Audit" />

       </Properties>

    </RMEntity>

</Holds>
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Retention period update
To update the retention period of an existing phase to null, you need to include the retention 
period properties (RetentionPeriodYears, RetentionPeriodMonths and RetentionPeriodDays) in 
the XML file with no value. 

Below is sample XML of a phase entity for the File Plan Import Export tool:

<RMEntity Type="Phase" Name="phase 1">

                  <Properties>

                        <Property Name="PhaseAction"></Property>

                        <Property Name="PhaseNumber" Value="1" />

                        <Property Name="ExportFormat"></Property>

                        <Property Name="IsScreeningRequired" Value="false" />

                        <Property Name="DisposalSchedulePtr">

                              <ObjectRef ClassId="DisposalSchedule" ObjectId="mySchedule" />

                        </Property>

                        <Property Name="PhaseName" Value="phase 1" />

                        <Property Name="RMEntityDescription" />

                        <Property Name="RetentionPeriodMonths" />

                        <Property Name="RetentionPeriodYears"  />

                        <Property Name="RetentionPeriodDays"  />

                        <Property Name="AlternateRetentions">

                              <ObjectValue Type="AlternateRetention">

                                    <Properties>

                                          <Property Name="RetentionBase" Value="CutoffDate" />

                                          <Property Name="ConditionXML" Value="&lt;response 
xmlns=&quot;http://filenet.com/namespaces/wcm/apps/
1.0&quot;&gt;&lt;objectset&gt;&lt;count&gt;1&lt;/
count&gt;&lt;customobject&gt;&lt;properties&gt;&lt;property&gt;&lt;symname&gt;CurrentA
ctionType&lt;/symname&gt;&lt;operator&gt;IS EQUAL&lt;/operator&gt;&lt;value&gt;6&lt;/
value&gt;&lt;/property&gt;&lt;/properties&gt;&lt;aggregation&gt;&lt;/
aggregation&gt;&lt;sql&gt; AND ([CurrentActionType] = 6)&lt;/sql&gt; &lt;/
customobject&gt;&lt;/objectset&gt;&lt;/response&gt;" />

                                          <Property Name="RetentionPeriodMonths" Value="0" />

                                          <Property Name="RetentionPeriodYears" Value="2" />

                                          <Property Name="RetentionPeriodDays" Value="0" />

                                    </Properties>

                              </ObjectValue>

                        </Property>

                  </Properties>

            </RMEntity>
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Rendition Engine

Publishing
See the following sections for additional troubleshooting topics related to publishing:

Application Engine > Workplace > Search > “Search Designer (or Publish Designer) does not start 
when Application Engine uses WebLogic 9.2” on page 19.

Problems using publishing templates
A publishing template might not have the proper MIME type. A template can be assigned an 
incorrect MIME type when it is checked in without using the Publishing API. (For example, the 
template can be checked in by using Enterprise Manager.) 

Publishing does not work
If publish requests have an IN QUEUE status but are not being processed, check the Publishing 
Configuration to make sure the dispatcher is enabled, and the Rendition Engine connection is set 
up properly for transformation publishing.
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IBM FileNet Connectors for SharePoint

Document Libraries

Kerberos authentication failed. Please check system configuration.
Causes: 

• Kerberos configuration information is missing or incorrect in the web.config file. 

• The FileNet P8 server is not configured for Kerberos.

• The FileNet P8 server is not running.

Solution: Contact the IBM FileNet P8 system administrator.

Authentication errors occur and prevents communication.
If you can navigate to the web service locally from a SharePoint server, but from a remote 
Document Library server an authentication error occurs and prevents communication, use one of 
the following options to resolve this problem.

Solution:

Use the Configuration Manager

 1. Open the Configuration Manager and click the Collection Sources tab. 

 2. Click Add to open the Collection Sources window. 

 3. Enter the custom web services URL address. Use the IP instead of the machine name.

You optionally change the authentication mode from NTLM to Digest. However, this is a weaker 
form of authentication than NTLM.
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Application servers

WebSphere

Tips
• Verify both WebSphere and Workplace are running.

• Open the admin console, under your node, expand Applications, and click Enterprise Applications. 
Verify that “app_engine_war” has started. (The green arrow under status indicates that it is 
running.)

• Verify the app_engine.war file is installed and deployed on Application Engine. If not, execute the 
create_app_engine_war script (located in AE_install_path/FileNet/AE/deploy or AE_install_path/
FileNet/deploy) to create it manually.

• Attempt to connect directly through WebSphere's default port (usually 9080). If you can connect 
through port 9080 and not port 80 (the HTTP server), then you will need to regenerate the plug-in 
and restart the HTTP server.

• See the following section for additional troubleshooting topics related to WebSphere:

Application Engine > Workplace operations > 

Application server does not start after installation and shutdown
Cause: This typically occurs if Global Security is not enabled before Content Engine installation. 

If Global Security is not enabled before Content Engine installation, the Content Engine installer 
automatically enables it, which requires valid LDAP users. If any LDAP information is incorrect, 
you will need to modify your LDAP settings. Also note, the WebSphere server User ID (during 
Content Engine installation, this is referred to as the WebSphere Administrative Login) must 
reside within the LDAP Base Distinguished Name that you specified during Content Engine 
installation.

Solution:

1. Launch \IBM\WebSphere\AppServer\profiles\profile\bin\wsadmin –conntype NONE.

2. At the wsadmin> prompt, type “securityoff”, then “exit”.

3. Start the application server again.

4. Launch the console and make necessary changes to the LDAP security settings. 

NOTE WebSphere will display an error if you try to save your changes with parameter values 
that are still incorrect. 

Creating FileNet P8 domain or object store fails, when database is DB2 for z/OS
For DB2 for z/OS: If Content Engine’s bootstrap user (ce_bootstrap_admin) has not been granted 
at least WebSphere’s “Monitor” role, or some higher level of administrative permission, the null 
pointer exception stack trace will be logged in the WebSphere log, and you will receive 
unexpected exceptions. This might take place especially during initial creation of the FileNet P8 
domain or object store. The reason is that the server will treat the database as DB2 for LUW.

For databases other than DB2 for z/OS: If the bootstrap user has not been granted at least the 
“Monitor” role, the null pointer exception stack trace will be logged in the WebSphere log, but the 
application will function correctly, except that any other configuration errors in the data sources 
will not generate warning messages in the P8 error and trace logs.
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Solution:

1. Make sure you know the credentials of the LDAP account that has been assigned as the 
bootstrap user (ce_bootstrap_admin), also known as the Content Engine System User. 

During initial installation, this account’s name is collected by the Configuration Manager and 
stored in the CEMPBoot.properties file that is archived in the Content Engine EAR file.

2. In WebSphere, make sure that the Content Engine bootstrap user has been granted an 
administrative role of at least Monitor.
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WebLogic

Tips
• Verify Workplace is deployed and the target server has been started.

• See the following sections for additional troubleshooting topics related to WebLogic:

– Application Engine > Workplace > Search > “Search Designer (or Publish Designer) 
does not start when Application Engine uses WebLogic 9.2” on page 19.

– Content Engine > Deployment > “Content Engine failed to deploy” on page 22.

– Content Engine > “Content Engine Java and .NET APIs” on page 32.

– Process Engine > Component Manager > “Auto-starting Component Manager as a 
WebLogic servlet causes a stack trace error” on page 43.
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Browsers

Microsoft Internet Explorer

“A script on the page is causing Internet Explorer to run slowly. If it continues to run, 
your computer might become unresponsive. Do you want to abort the script?”
This error can occur in Internet Explorer when an application attempts to process a large amount 
of information. Select “No.”

After you change the text size, the text changes back to the normal size
Cause: In Microsoft Internet Explorer 6.0 SP1, you change the text size on a web page to a 
smaller or larger text size using the Text Size option on the View menu. After you click a link on the 
web page, the text changes back to the normal size.

Solution: This problem has been fixed in Internet Explorer 6.0 SP2, which is available with 
Microsoft Windows XP SP2. Refer to the Microsoft Knowledge Base for additional information 
about article 887800.

Netscape Navigator

The Designer applications flash bright blues, greens, and red or black tweed
This occurs with certain combinations of operating systems and graphics controllers. 

Workplace applications that require the JRE plugin do not download them
Manually download the plugin.

Clicking on a Word document link or icon opens an empty Netscape window
This is expected Netscape behavior. (Internet Explorer closes the extra window.)
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General

TOC and Search functionality causes a JavaScript™ errors or does not work
Cause: The user's browser client machine does not have JavaScript™ support enabled. 

Solution: Open the browser's Preferences or Internet Options settings, and enable the JavaScript 
support option. For example:

• In Netscape Navigator 7.0, navigate to Preferences > Advanced > Scripts & Plugins and select 
Navigator under Enable JavaScript for. 

• In Microsoft Internet Explorer 6.0.x, navigate to Tools > Internet Options, click the Security tab > 
the Local Intranet Web content zone > the Custom Level button, and select Enable under the 
Scripting option.

Online Help Search does not work (null pointer error)
• If you receive null pointer errors when attempting to search the online Help under WebLogic, 

you might have deployed the compressed ecm_help.war version of the FileNet P8 
documentation. Although some versions of WebLogic support deployment of WAR-file-based 
web applications, you cannot deploy the ecm_help.war on this application server platform. You 
must instead use the fully expanded FileNet P8 documentation directory structure. Otherwise, 
the searches within the FileNet P8 documentation will not work; you will receive a null pointer 
error. 

For more information, see the IBM FileNet P8 Platform Installation and Upgrade Guide for 
instructions. To download this document from the IBM Support site, see “Access IBM FileNet 
documentation” on page 10. 
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Process Engine errors
When PE detects errors, it writes messages to the application log in the Event Viewer. If you are 
having problems with PE or PE services, check the Event Viewer for error messages.

Even when you are not having problems with the service, you should check the Event Viewer 
periodically for error messages about potentially troublesome conditions that you have not yet 
identified.

The application log contains information about PE services. If tracing is turned on for the server 
and the VWKs trace is turned on from the vwtool application, VWExceptions are logged as:

• Error An event that logs a significant error. For example, “Problem configuring a CE 4.0 connec-
tion”. The PE directory server cannot communicate with CE (check PE Service User logon creden-
tials): The user is not authenticated. 

• Information An event that describes the successful operation of an application, driver, or service. 
For example, if you could not log on because of an invalid user name.

View messages using the Event Viewer

1. From the Start menu, select Programs > Administrative Tools > Event Viewer.

2. Under Event Viewer (Local), select Application log to display events in the details pane.

3. Click the Source column heading to sort the messages by error source.

4. Scroll through the list to find errors related to PE.

5. Double-click the event to view the event message.

Errors that require administrator intervention
The following table lists some of the errors that you might encounter. This is not a comprehensive 
list of all errors that might be generated, but only a list of the ones to be aware of. 

These errors generally will require intervention by an administrator.

Category Error Tuple Description Action

Process 
Engine

213,2,300 Internal Error -- see system log for 
cause of error.

Note the error in the syslog 
and contact your service 
representative. Recycle the 
PE software. 

Process 
Engine

213,4,550 Write to file truncated - disk full? Check the available disk 
space and verify the disk is 
not full.

Process 
Engine

213,1,301 Not enough available memory. Verify you have enough 
memory.

Recycle the PE service.

Process 
Engine

213,75,20 Out of memory. Close any unnecessary 
programs that might be 
running on the machine.

Process 
Engine

213,109,32 Fatal VW Error -- see system error 
log.

Recycle the PE software.
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Database 213,109,52 Duplicate index name detected. Timing related. 

Recycle the PE software.

Transfer 213,109,65 Request to modify database 
schema failed Transfer, clean 
repository, reinitialize database, 
etc. is not allowed at this time. 

Recycle the PE software.

Check schemastatus with 
vwtool. If another operation 
is active, wait for it to 
finish. If no other 
operations are active, 
recycle the server and 
client software and try 
again.

Rules 213,109,190 Unable to send rules message. If the Rules Engine is 
configured, verify that the 
Rules Engine is up and 
running. If it is not running, 
start it from the Process 
Engine Task Manager. This 
might indicate a network 
error or other problems on 
the Rules Engine server.

Rules 213,109,191 Unable to receive rules message. If the Rules Engine is 
configured, verify that the 
Rules Engine is up and 
running. If it is not running, 
start it from the Process 
Engine Task Manager. This 
might indicate a network 
error or other problems on 
the Rules Engine server.

Process 
Engine

213,109,253 Object service busy on server. Shutdown all programs and 
try again. The object 
service on the server has 
structures in memory which 
cannot be deleted. 

Recycle software on the 
server and retry the 
initialize operation.

Contact your support 
representative.

Category Error Tuple Description Action
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Email Manager errors
Server errors
When an error occurs in Email Manager:

• Messages are written to the Application section of the Windows Event Viewer.

• Log files are written to the Logs folder in the Email Manager installation folder.

If you are having problems with an Email Manager component, check the Event Viewer for error 
messages then check the Email Manager log files for additional details.

Windows Event Viewer
Windows Event Viewer contains the following types of Email Manager messages:

• Information Describes a successful start or stop of the Email Manager services.

• Error Identifies an error in Email Manager that requires administrator intervention.

View messages using the Event Viewer

1. From the Start menu, select Programs > Administrative Tools > Event Viewer.

2. Under Event Viewer (Local), select Application log to display events in the details pane.

3. Click the Source column heading to sort the messages by error source.

4. Scroll through the list to find errors related to Email Manager.

5. Double-click the event to view the event message.

Log files
Further details might be found in the Email Manager log files, which are by default located in the 
Logs folder in the Email Manager installation folder. The possible log levels are listed below:

• Fatal errors Written to the log when a severe problem or critical condition occurs. Contains 
minimum logging detail.

• All errors Written to the log when an error condition occurs, such as when an attempt to connect 
to a server fails. 

• Warnings Written to the log when a warning condition occurs, such as when the server cannot 
understand a communication sent to it. 

• Information Written to the log when a significant action occurs, such as when a document is 
captured.

• Trace Written to the log at individual steps. Contains the most verbose logging detail, which is 
useful only for debugging purposes.

NOTES

• The folder that is used to store log files is specified in Email Manager’s Configuration Manager in 
the Configuration Options screen.

• You can control the types of log entries created in the log file in the Configuration Manager.
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Client errors
When an error occurs on an Email Manager client machine, errors are written to an “errlog.log” 
log file that is located in the user’s %TEMP% folder.

NOTES

• You can change the temp folder by changing the machine’s environment variable settings.

• To access the temp folder from a command prompt, enter:

start %temp%

• In some cases, Email Manager Web Service errors corresponding to client errors might be logged 
on the Email Manager server. You can view these errors in the Application section of the Event 
Viewer.

Errors that require administrator intervention
The following table lists Email Manager errors that you might encounter. It is not a comprehensive 
list but contains errors that you need to be aware of and that generally require intervention from 
an administrator.

Category Event ID Description Action

Universal 
File 
Importer

0x80004027 Object store unavailable. The 
FileNet P8 connector cannot contact 
the FileNet P8 object store or the 
service is in the “Stopped” state. 

Verify the user that the 
UFI service is running 
under has permission to 
access network 
resources.

Verify the object store is 
running.

Verify the network 
connection is working.

Universal 
File 
Importer

0x8004021A Invalid object store. The object store 
specified in the Index Template is 
missing or invalid.

Verify the object store 
specified in the Index 
Template exists and is 
valid.

Universal 
File 
Importer

0x80070534 COM Permission. The user that the 
UFI service is running under does 
not have permissions to instantiate 
FileNet P8 or Email Manager COM 
Objects.

The UFI service is 
running as a user: Verify 
that user has permissions 
to instantiate COM 
objects on the server.

Universal 
File 
Importer

0x8007052E Logon failed. The user login 
information specified in the Index 
Template is invalid.

Verify the logon 
information for the user 
specified in the Index 
Template is valid.
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Universal 
File 
Importer

0x8007054B RPC server unavailable. The FileNet 
P8 connector cannot contact the 
FileNet P8 object store or the 
service is in the “Stopped” state.

Verify the user under 
which the UFI service is 
running has permission to 
access network 
resources. 

Verify the object store is 
running.

Verify the network 
connection is working.

Universal 
File 
Importer

0x800706BA RPC server unavailable. The FileNet 
P8 connector cannot contact the 
FileNet P8 object store or the 
service is in the “Stopped” state.

Verify the user under 
which the UFI service is 
running has permission to 
access network 
resources. 

Verify the object store is 
running.

Verify the network 
connection is working.

Universal 
File 
Importer

0x80090311 No Authority For Authentication. 
The FileNet P8 connector cannot 

contact the FileNet P8 object store 
or the service is in the “Stopped” 
state.

Verify the user that the 
UFI service is running 
under has permission to 
access network 
resources.

Verify the object store is 
running.

Verify the network 
connection is working.

Universal 
File 
Importer 

0x80AA0C00 COM Error. A FileNet P8 internal 
error occurred while processing the 
file.

Contact your support 
representative for 
assistance.

Exchange 
Connector

N/A Failed to connect to exchange 
server "%s" using mailbox "%s".

Verify the Exchange 
Server is running.

Verify the password of the 
Exchange Connector 
service account has 
changed.

Verify the Exchange 
Connector service 
account user can connect 
to the Exchange Server 
using NT authentication.

Category Event ID Description Action
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Exchange 
Connector

N/A Could not open log file in directory 
“%s”.

Verify the log file 
directory specified in the 
Configuration Manager 
exists and is accessible to 
the Exchange Connector 
service account.

Exchange 
Connector

N/A Could not get target ID from 
message. 

Verify the message was 
created by the eMgr 
client.

Messages in the client 
folder have been copied 
to the folder manually 
instead of by the eMgr 
client. Use the eMgr client 
for this purpose, or copy 
the email to a public 
folder that the Email 
Manager is configured to 
monitor, which is not the 
same as the client folder 
configured for Email 
Manager.

Exchange 
Connector

N/A Service does not start – and no log 
file is created.

A problem occurred 
creating the log file, or 
connecting to the 
database. Verify the disk 
space. Check the 
Application Event Viewer 
for more information.

Exchange 
Connector

N/A The user %s was not found in the 
exchange address book.

The user whose private 
mailbox is to be 
monitored could not be 
found. The user 
information might be 
ambiguous, or 
misspelled.

Exchange 
Connector

N/A Couldn't open private mailbox for 
user %s.

Verify the Exchange 
Connector service 
account has appropriate 
permissions on the user’s 
mailbox.

Exchange 
Connector

N/A Failed to create sub folder "%s". Verify the Exchange 
Connector service 
account user has ‘Create 
Sub-folders’ permission 
on the parent folder.

Category Event ID Description Action
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE



 Email Manager errors
Errors that require administrator intervention

78
Exchange 
Connector

N/A Couldn't create file "%s". Verify the temporary 
directory specified in the 
configuration manager 
exists, and that the Email 
Manager service account 
user has sufficient 
permissions. Also verify 
that there is sufficient 
disk space available on 
the Email Manager 
server.

Exchange 
Connector

N/A Can't monitor more than %i folders. 
Folder "%s" will not be monitored.

The maximum number of 
“active” monitored 
locations has been 
exceeded. Utilize 
scheduled profiles (with a 
schedule set to an 
appropriate interval).

Lotus® 
Connector

N/A Instantiation error creating a data 
store object: "An error occurred 
while attempting to connect to the 
Data Store: "Cannot open database 
requested in login '<dbname>'. 
Login fails.Login failed for user 
'<username>'.""

Verify that the Email 
Manager database is 
available and the 
database credentials 
specified in the 
Configuration Manager 
are correct.

Category Event ID Description Action
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Lotus 
Connector

0x80a97010 Notes® error while attempting to 
initialize a new Notes Session: 
"Notes error: Wrong Password. 
(Passwords are case-sensitive - be 
sure to use correct upper and lower 
case.) (0x80040FA0)".

If the password for the 
default Notes ID file has 
changed, update the 
Notes password in the 
Configuration Manager.

Verify that the Lotus 
Connector service 
account user is a valid 
user (not the 
LocalSystem account) 
and has “run as service” 
privileges. Log in to 
Windows using the 
specified account and 
verify that the user can 
use the Lotus Notes® 
client to connect to the 
required Domino® 
Servers using the current 
location and ID file (the 
location document should 
explicitly reference the ID 
file). Verify that the Notes 
password is configured in 
the Configuration 
Manager.

Lotus 
Connector

0x80a97010 Notes error while attempting to 
initialize a new Notes Session: "A 
password is required."

If the password for the 
default Notes ID file has 
changed, update the 
Notes password in the 
Configuration Manager.

Lotus 
Connector

0x80a97028 Notes cache 'Notes Address Shared 
Cache' warning: both public and 
private address book lookup options 
are disabled. Address book lookup, 
group resolution, mailbox name 
lookup, dynamic security mapping 
and global post-processing will be 
disabled.

In the Lotus Connector 
Advanced Options, 
enable either public or 
private address book 
lookup as both are 
currently disabled (public 
address book lookup is 
enabled by default).

Lotus 
Connector

0x80a9601e Cache database error. Unable to 
open the cache database 
'<server>!!<dbpath>': "The database 
does not exist (or the Notes user 
does not have permission to see it). 

Verify the server name 
and database path."

Verify the Cache server 
and Cache database 
specified in the Lotus 
Connector Advanced 
Options still exist and are 
available for use.

Category Event ID Description Action
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Lotus 
Connector

0x80a95013 Crawler error opening Domino 
database '<server>!!<dbpath>': "The 
database does not exist (or the 
Notes user does not have 
permission to see it). 

Verify the server name 
and database path."

Verify the specified 
Domino Database still 
exists and can be opened 
by the Lotus Connector 
Notes user. 

Lotus 
Connector

0x80a95015 Parser error saving document 
'<UNID>': "Notes error: Network 
operation did not complete in a 
reasonable amount of time; please 
retry (0x80040FA0)"

The Domino server might 
not be available. Verify 
Notes connectivity, 
network connections and 
the Domino server load to 
determine why requests 
are timing out.

Email 
Manager 
Web 
Services

-500100102 No ObjectStore object currently 
exists.

The FileNet P8 CE object 
store might not be 
available.

Verify FileNet P8 CE is 
running and is accessible.

Email 
Manager 
Web 
Services

-500100103 Error in instantiating ObjectStore. The FileNet P8 CE object 
store might not be 
available.

Verify FileNet P8 CE is 
running and is accessible.

Email 
Manager 
Web 
Services

-500100104 Unable to gain access to object 
store.

The user credentials 
specified in the Email 
Manager Client might not 
be valid in the selected 
object store.

Email 
Manager 
Client

-50012 Library is not accessible. The FileNet P8 CE object 
store might not be 
available. 

Verify FileNet P8 CE is 
running and is accessible.

Email 
Manager 
Client

-50018 Failed to load the list of available 
libraries from the server. Please 
report this problem to your network 
administrator.

The FileNet P8 CE object 
store might not be 
available. 

Verify FileNet P8 CE is 
running and is accessible.

Category Event ID Description Action
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Email 
Manager 
Client

-50019 Failed to load the list of available 
document properties from the 
server. Please report this problem to 
your network administrator.

The Email Manager 
database might not be 
available. 

Verify the database 
server is accessible.

Email 
Manager 
Client

-50020 Failed to initialize the eMgr Client 
API. Please report this problem to 
your network administrator.

The Email Manager 
server might not be 
available. 

Verify the Email Manager 
server is running.

Email 
Manager 
Client

-61006 Failed to load profiles. Verify the client error log 
file to determine the 
reason for the failure. 

Contact your support 
representative for further 
assistance.

Email 
Manager 
Client

-83000 An error occurred while saving 
profile.

Verify the client error log 
file to determine the 
reason for the failure. 

Contact your support 
representative for further 
assistance.

Email 
Manager 
Client

-50001 No data was returned. Contact your support 
representative for further 
assistance.

Email 
Manager 
Client

-60001 An error occurred while converting 
XML.

Contact your support 
representative for further 
assistance.

Email 
Manager 
Client

-60002 Failed to communicate with 
eCWWebServices.

The Email Manager 
server might not be 
available. 

Verify the Email Manager 
server is running.

Category Event ID Description Action
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Email 
Manager 
Client

-60006 No properties are defined on the 
server.

The database server 
might not be available.

The database used by 
Email Manager might 
have been deleted and 
changed to a new 
database. IIS must be 
reset on the Email 
Manager Server for the 
new database to take 
effect.

Email 
Manager 
Client

-61008 GetDocument: Access is denied. Verify the Access Control 
List (ACL) of the email 
being retrieved in FileNet 
P8 to determine whether 
the user has permissions 
to access the document.

Email 
Manager 
Client

-80001 An error occurred while converting 
XML. 

Contact your support 
representative for further 
assistance.

Email 
Manager 
Client

-80002 Failed to communicate with 
eCWWebServices. 

Contact your support 
representative for further 
assistance.

Email 
Manager 
Client

-80007 Component has not yet been 
initialized.

Contact your support 
representative for further 
assistance.

Email 
Manager 
Client

-2147221233 The operation failed. The path or name of the 
Email Manager client 
public folder being used is 
incorrect. Verify the folder 
exists and the current 
user has access to the 
public folder. 

See the Email Manager 
Setup Guide for details on 
permissions that must be 
assigned to the user.

If a non-English version 
of Outlook is being used, 
contact your support 
representative for 
assistance.

Category Event ID Description Action
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Email 
Manager 
Client

-2147467259 -2147467259: The operation failed. The current user does not 
have sufficient 
permissions to access the 
Email Manager client 
public folder. 

Se the Email Manager 
Setup Guide for details on 
permissions that must be 
assigned to the user.

Email 
Manager 
Client

-2147024891 -2147024891: The operation failed. The current user does not 
have sufficient 
permissions to access the 
Email Manager client 
public folder when 
processing e-mails with 
attachments. 

See the Email Manager 
Setup Guide for details on 
permissions that must be 
assigned to the user.

Email 
Manager 
Client

N/A 911:  Object variable or With block 
variable not set.”

Shut down the Lotus 
Notes client and restart 
Lotus Notes client. Then 
click on the eMgr client 
icon.

Category Event ID Description Action
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Content Federation Services Errors 
Content Services (CFS-CS) and IICE (CFS-IICE) 
You can access the list of federation errors from the Rules Management page of the Federation 
Administrator application.

General and query phase errors
Error ID Description

50 Unable to update the status of the run

51 Unable to retrieve IICE user

52 Unable to retrieve IICE repository

53 Query error. Unable to open the query

54 Query error. Unable to execute the query

55 Query error. Unable to fetch rows from the query

56 Query error. Unable to get the unique id from the current row

57 Invalid selected class name. Please update the rule

99 Unexpected error. See log file for more information
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Import errors

Error ID Description Action

100 Wrong object store in import request The object store name in the import request is 
different from the name previously used to 
federate the version series.  The destination 
object store cannot be changed once a 
version series has been imported.

101 Failed parsing the import request XML The import request is not valid XML data, or 
the XML contains data that is not a valid 
import request.

102 No document references found in the 
import request

There are zero external document references 
in the import request. A valid request must 
contain at least one document reference. 

103 Multiple document references in the 
import request point to the current 
FileNet P8 document

The import request contains multiple 
document references that point to the current 
FileNet P8 document. Only one document 
reference in an import request can point to the 
current FileNet P8 document. 

104 Import request contains out of order 
document references

One or more of the document references in 
the import request are out of order, when 
compared to the existing version series 
mapping data (fdb_version_series table). 
Once an external document is federated, the 
position of each version in the document 
cannot change when the document is re-
imported. 

105 Current FileNet P8 document is reserved The current federated document (as defined in 
the version mapping data) in CE has been 
checked out from the Content Engine and has 
an associated reservation object.

106 Current FileNet P8 document is not the 
tip of the version series

The current federated document (as defined in 
the version mapping data) in CE is not the tip 
of the version series. That is, the document 
has been checked out and back in.

107 Current FileNet P8 document does not 
exist

The current federated document (as defined in 
the version mapping data) in CE does not 
exist. The document has been deleted from 
the Content Engine.

108 Invalid Object Store name The object store name in the request is invalid 
That is, the object store does not exist.

109 Property constraint violation A property in the import request contains 
invalid data (when mapped to the CE 
property).
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110 Duplicate external document URN in 
import request

The import request contains duplicate 
document references. That is, the URNs of 
two or more documents in the request are 
identical. 

111 Invalid isContentVolatile flag in import 
request

The isContentVolatile flag in the import 
request is inconsistent with the existing value 
of the flag.  Once the volatile content setting is 
established for a version series, it cannot be 
changed. 

112 The target folder does not exist The target folder in the import request does 
not exist (applies only when creating the first 
version of a series).

113 No fixed storage area is associated with 
the fixed content device

There is no fixed storage area associated with 
the fixed content device in the import request.  
Federated documents cannot be created 
unless a fixed storage area is associated with 
the fixed content device.

114 The importer was unable to lock down 
the content of the external document 
before creating the federated document

The importer was unable to lockdown the 
content of the external document before 
creating the federated document.

Error ID Description Action
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Export errors

Error ID Description

200 Unable to retrieve IICE item

210 Unable to process IICE item

220 Unable to export IICE item

230 Unable to retrieve IICE user to process the batch

240 Unable to retrieve IICE repository to process the batch

250 Unable to retrieve data map to process the batch

260 Lockdown not supported by the repository for this type of item

299 Item being re-exported as part of an upgrade process
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Software builds and Win32 errors
Identifying software build information
When you contact your support representative for assistance, the support engineer might need to 
know the build, fix pack or release information for your software. 

Display the build information for Workplace

1. Display a page from the application in your browser.

2. Use the browser’s View source command to display the source HTML for the page. The build 
information is provided by the “BuildName” and “BuildDate.”

For example:

<meta name='BuildName' content='rec170.009.001'>

<meta name='BuildDate' content='08/06/2004'>

For more information, see the IBM FileNet P8 Version Tools Technical Notice. To download this 
document from the IBM Support site, see “Access IBM FileNet documentation” on page 10.

Win32 0x800xxxxx error decoding
Refer to the MSDN Library for decoding Win32 error codes. 
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Notices
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
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your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can sen
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in thi
publication at any time without notice.

BM Corporation
46A/G4
55 Bailey Avenue
an Jose, CA 95141-1003
.S.A.

uch information may be available, subject to appropriate terms and conditions, including in some cases,
ayment of a fee.

he licensed program described in this document and all licensed material available for it are provided
y IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
ny equivalent agreement between us.

ny performance data contained herein was determined in a controlled environment. Therefore, the
esults obtained in other operating environments may vary significantly. Some measurements may have
een made on development-level systems and there is no guarantee that these measurements will be the
ame on generally available systems. Furthermore, some measurements may have been estimated through
xtrapolation. Actual results may vary. Users of this document should verify the applicable data for their
pecific environment.

nformation concerning non-IBM products was obtained from the suppliers of those products, their
ublished announcements or other publicly available sources. IBM has not tested those products and
annot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
roducts. Questions on the capabilities of non-IBM products should be addressed to the suppliers of

hose products.

ll statements regarding IBM’s future direction or intent are subject to change or withdrawal without
otice, and represent goals and objectives only.

his information contains examples of data and reports used in daily business operations. To illustrate
hem as completely as possible, the examples include the names of individuals, companies, brands, and
roducts. All of these names are fictitious and any similarity to the names and addresses used by an
ctual business enterprise is entirely coincidental.

OPYRIGHT LICENSE:

his information contains sample application programs in source language, which illustrate programming
echniques on various operating platforms. You may copy, modify, and distribute these sample programs

any form without payment to IBM, for the purposes of developing, using, marketing or distributing
pplication programs conforming to the application programming interface for the operating platform for
hich the sample programs are written. These examples have not been thoroughly tested under all

onditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
rograms.
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IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked
terms are marked on their first occurrence in this information with a trademark symbol (® or ™), these
symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law trademarks in other countries. A
current list of IBM trademarks is available on the Web at ″Copyright and trademark information″ at
www.ibm.com/legal/copytrade.shtml.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in the United States,
other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks of others.
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE



Trademarks
94
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE



Trademarks
95
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE



Trademarks
96

�

Pro

Prin

GC3
���

gram Number: 5724-R76, 5724-R80, 5724-R81, 5724-R86, 5724-R93, 5724-R96,
5724-S03, 5724-S17, 5724-S19

ted in USA

1-5493-03
IBM FILENET P8 PLATFORM TROUBLESHOOTING GUIDE


	Revision log
	About this document
	Document organization
	Recommended documentation
	Access IBM FileNet documentation

	Contact customer support

	General
	Tips
	Directory servers
	Databases
	Server date and time
	Release version and build information


	Application Engine
	Workplace
	Log on and log off
	Unable to log on
	Cannot access Image Services documents by proxy from Workplace
	“Credential is not available”
	Unable to log out of Workplace after using Image Viewer

	Document processing
	Workplace folders fail to refresh after filing or unfiling a document
	Out-of-memory errors (java.lang.OutofMemoryError)
	System performance is not optimal

	Workplace applications
	Unable to access Workplace applications
	File Tracker
	File Tracker functionality fails in a Windows Vista FDCC environment
	File Tracker does not keep track of checked-out files

	Application Integration
	Unable to authenticate using Application Integration for Microsoft Office

	Image Viewer
	Transparency for annotations is not displayed by default in Image Viewer


	User interface
	Images do not display in Workplace
	Name field on Tasks pages is truncated
	Localization
	Workplace and Workplace applets do not display a newly selected language


	Search
	Cannot execute a search
	Content-based searches do not return results
	Search Designer (or Publish Designer) does not start when Application Engine uses WebLogic 9.2
	Full-text retrieval is not available
	Web Services indicate Application Engine cannot be found: "Wrong server name”



	Workplace XT
	General
	Log on error when the trust association is enabled on WebSphere 6.0.2.17
	The folder selector does not display correctly
	File Tracker functionality fails in a Windows Vista FDCC environment
	Cannot upload or download a file larger than 100 MB

	Application Integration BCS
	Unable to see the IBM ECM tab on the Microsoft® Office 2007 Ribbon
	Unable to send e-mail


	Content Engine
	Deployment
	Content Engine diagnostic information
	Content Engine failed to deploy
	The size of the SystemOut.log file causes errors

	Enterprise Manager
	Cannot access Enterprise Manager features
	Enterprise Manager does not load
	Recently created objects or properties do not display or display incorrectly
	DB2 error occurs while adding a large number of properties to a document class
	Object stores
	Object stores are unavailable
	Cannot connect to an object store
	Object store creation
	Cannot create an object store
	The “Create an object store” wizard fails during object store creation

	Object stores - object management
	Unable to declare records after deleting an object store
	Cannot add documents using a CBR-enabled document class
	Cannot add documents to an Oracle-based object store
	Cannot delete expired documents from a Snaplock device
	Documents are not being indexed for content or properties
	Documents have no audit history
	Creating a large choice list in IBM DB2 for z/OS fails with SQL error code 805.

	Exporting and importing
	The import operation fails
	Opening or parsing an import file cause an error
	Associated DRCRs fail during import
	Associated subscriptions fail during import


	Storage areas
	Incorrect storage maximums can disable a storage area
	Storage area counters
	Cannot add documents to a file or fixed storage area
	Cannot create a file storage area using a remote or local share
	Do storage area maximums control the fixed content device?
	What is the staging area directory used for? Do I need to back it up?
	Storage area counters do not change
	Do document annotations have to be in the same fixed storage area?
	Where are document classes stored when it has no storage area or storage policy?


	Content Engine Upgrader (version 4.0.1 to 4.5) tool
	The Content Engine Upgrader tool database connection test fails

	Content Engine Java and .NET APIs
	Search
	WebLogic
	A call to SearchScope.fetchObjects with the continuable parameter returns an error




	Databases
	Microsoft SQL Server
	Cannot create a row that exceeds 8060 bytes
	Adding an index on a property indicates the limit of 249 indexes has been reached
	Creating an index on a large object store exceeds the DTC timeout

	Oracle
	ORA-12535 TNS: Operation timed out error / ORA-12541 No listener error
	Oracle database queries are not finding documents and folders as expected

	DB2 for z/OS
	AddOn installation can fail with resource unavailable exception


	Business Process Management
	Process Engine
	Server processing errors
	vwtool loadstatus
	“Not enough room in the archiver memory buffer”

	Workflows
	“This workflow contains errors. It cannot be launched”
	“Unable to get step element”
	Users SysAdminG or SysConfigG cannot participate in workflow-related activities
	System performance is deteriorating rapidly or the server hard drive is thrashing
	Items from a specific work class are processing slowly
	Nearing the maximum BLOb size
	Cannot connect to remote Oracle database


	Process applications
	Unable to access Process applications
	Cannot access workflow tasks
	Process Configuration Console
	Cannot Launch Process Configuration Console
	Problems started after an isolated region was recovered

	Process Designer
	Validate function does not detect invalid function arguments in a workflow definition

	Process Analyzer
	Events are not published to the Process Analyzer
	Process Analyzer incorrectly combines data in queues

	Component Manager
	Auto-starting Component Manager as a WebLogic servlet causes a stack trace error
	Restarting Component Manager causes an error
	Cannot viewing registered component classes in Process Configuration Console



	Security
	Application Engine, Content Engine, and Process Engine
	Connection fails
	Cannot delete a security policy from a large object store
	Security permissions fail to import successfully
	Queries for users and groups time out before returning results
	Renaming a user while using Windows non-local authentication causes errors
	How to change LDAP shortname in Process Engine if dn remains the same

	Windows’ Data Execution Prevention feature prevents BPM- related Java processes from running

	Content Federation Services
	Content Services (CFS-CS) and IICE (CFS-IICE)
	Document federation
	Resolving deadlock errors when federating large quantities of documents
	Mimetype for a federated document is incorrect

	Import and Export
	Content Services export errors
	Import error is not cleared when rule is rescheduled
	Mapping the Date Last Modified property
	Fixed storage area issues
	Monitoring the progress of the CFS Import Agent
	Import fails when attempting to create a second version of a federated document
	E_OBJECT_MODIFIED error
	Importer error codes


	Image Services (CFS-IS)
	Network connections
	IP address for IS connection is not propagated to Content Engine application server
	Does IS limit the number of concurrent FileNet P8 users accessing documents
	Why does my custom application take up so many Image Services sessions?
	How many IS sessions do the IS import agents use?

	Document federation
	Where are federated IS Annotations stored in the Content Engine?
	Can I delete federated IS annotations from a FileNet P8 Platform application?
	Images federated from CFS-IS do not display properly in Image Viewer
	How large are IS annotations?
	Annotations are stored in a binary format that has a maximum size of 800 bytes. When they are federated into Content Engine, they are translated into an XML format with a maximum size between 2-3 KBs.
	How do I transfer my IS document class mapping from one object store to another?



	Records Manager
	General
	The RMBaseURL can become outdated when the RM URL changes
	New WSI retry configuration option
	Corrupted entities if Hold Sweep is terminated in the middle of its run

	File Plan Import and Export Tool
	Common causes of errors
	Manually creating a compliant XML file
	Observing the File Plan Import Export Tool functionality
	Subcategory schedule inheritance
	ConditionXML property
	Sample of ConditionXML for Alternate Retention
	Sample of Disposal Trigger with ConditionXML
	Sample of Dynamic Hold with ConditionXML
	Retention period update



	Rendition Engine
	Publishing
	Problems using publishing templates
	Publishing does not work


	IBM FileNet Connectors for SharePoint
	Document Libraries
	Kerberos authentication failed. Please check system configuration.
	Authentication errors occur and prevents communication.


	Application servers
	WebSphere
	Tips
	Application server does not start after installation and shutdown
	Creating FileNet P8 domain or object store fails, when database is DB2 for z/OS

	WebLogic
	Tips


	Browsers
	Microsoft Internet Explorer
	“A script on the page is causing Internet Explorer to run slowly. If it continues to run, your computer might become unresponsive. Do you want to abort the script?”
	After you change the text size, the text changes back to the normal size

	Netscape Navigator
	The Designer applications flash bright blues, greens, and red or black tweed
	Workplace applications that require the JRE plugin do not download them
	Clicking on a Word document link or icon opens an empty Netscape window


	FileNet P8 documentation
	General
	TOC and Search functionality causes a JavaScript™ errors or does not work
	Online Help Search does not work (null pointer error)


	Process Engine errors
	Errors that require administrator intervention

	Email Manager errors
	Server errors
	Windows Event Viewer
	Log files

	Client errors
	Errors that require administrator intervention

	Content Federation Services Errors
	Content Services (CFS-CS) and IICE (CFS-IICE)
	General and query phase errors
	Import errors
	Export errors


	Software builds and Win32 errors
	Identifying software build information
	Win32 0x800xxxxx error decoding

	Notices
	Trademarks




